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1   Introdução

O Kodak Capture Pro Software é ideal para imagens, processamento de 
formulários e aplicações de fluxo de trabalho e como uma aplicação 
independente. Ele gerencia digitalização em um e dois lados, indexação 
e processamento em lote, em cores, em preto e branco e em escala de cinza. 
Os lotes podem ser facilmente exportados para muitos dos aplicativos mais 
usados. O Capture Pro Software permite a plena utilização de todos os 
recursos dos scanners para máxima produtividade. Todas as funções são 
executadas no software; não é necessária nenhuma aceleração especial de 
hardware.

O Capture Pro Software foi criado para proporcionar velocidade, precisão 
e facilidade de operação. Ele permite o rendimento ideal do scanner 
e a máxima produtividade. Uma tela de alta velocidade e com várias páginas 
apresenta as imagens e os dados de índice opcionais, à medida que os 
documentos são digitalizados. Um conjunto completo de ferramentas 
baseadas em ícones está disponível para simplificar o gerenciamento das 
digitalizações. 

Este guia fornece as etapas básicas para criar um novo lote, digitalizar seus 
documentos, editar suas imagens de digitalização e enviar um lote. Além 
disso, uma descrição de janelas, menus e ferramentas também é descrita.

Documentação de 
suporte

Além deste Guia do usuário, a documentação a seguir também está 
disponível:

• Ajuda on-line — fornece informações sobre o produto, incluindo 
configuração detalhada, detalhes sobre a interface do usuário e muitos 
recursos avançados. Para localizar informações no arquivo de Ajuda, você 
pode usar o sumário, o índice ou o recurso de pesquisa. 

Para acessar a Ajuda, pressione F1, selecione o botão Ajuda em uma 
caixa de diálogo ou clique no ícone ? no canto superior direito de qualquer 
janela.

• Guia de introdução — apresenta procedimentos simples para iniciar 
a operação rapidamente, incluindo a instalação e inicialização do Capture 
Pro Software. Também são apresentados procedimentos para digitalizar 
usando configurações de trabalho predefinidas padrão. Um arquivo em 
PDF deste guia pode ser encontrado na seção Manuais e guias do site de 
suporte do Capture Pro Software: https://support.alarisworld.com/capture-
pro-software#Manuals

• Guia do administrador — fornece informações detalhadas sobre a criação 
de configurações de trabalho, que oferecerão aos usuários os meios mais 
eficientes de usar o Capture Pro Software. Também inclui informações 
sobre configurações de página, códigos de barras e códigos de patches, 
importação automática etc. Um arquivo em PDF deste guia pode ser 
encontrado na seção Manuais e guias do site de suporte do Capture Pro 
Software: https://support.alarisworld.com/capture-pro-software#Manuals

• Network Edition: Guia do sistema — apresenta os procedimentos de 
instalação do Capture Pro Network Edition. Um arquivo em PDF deste guia 
está disponível na seção Manuais e guias da página Suporte do site do 
Capture Pro Software: https://support.alarisworld.com/capture-pro-
software#Manuals

https://support.alarisworld.com/capture-pro-software#Manuals
https://support.alarisworld.com/capture-pro-software#Manuals
https://support.alarisworld.com/capture-pro-software#Manuals
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• Notas de versão — contêm informações que podem não ter sido 
disponibilizadas em outras documentações de apoio. Para visualizar as 
Notas de versão, acesse www.kodakalaris.com/go/kcsdownloads 
e navegue até a seção Estação de trabalho/software cliente do site.

Terminologia Antes de começar, é útil ter uma compreensão básica de algumas das 
terminologias utilizadas no Capture Pro Software. 

O Capture Pro Software é baseado em “trabalho”. Cada trabalho contém uma 
configuração definida para captura e processamento de um conjunto de 
documentos a ser digitalizado. 

Para digitalizar documentos em um trabalho, você precisa criar um lote para 
conter os documentos, imagens e dados digitalizados, antes de enviá-los.

O Capture Pro Software organiza os documentos digitalizados na seguinte 
hierarquia:

• Lote: contém um ou mais documentos digitalizados (semelhante a uma 
pasta ou arquivo suspenso contendo diversos documentos separados).

• Documento: contém uma ou mais páginas relacionadas a um único item 
(por exemplo, o conteúdo de um envelope).

• Página: são folhas físicas de papel que são alimentadas no scanner para 
produzir imagens.

• Imagem: representações eletrônicas de páginas digitalizadas.

Saída é o processo de envio do lote para o local/sistema de saída desejado, 
no formato escolhido.

Inicialização do 
Capture Pro Software

Se não estiver usando a edição Somente índice ou Importação automática, 
certifique-se de que o scanner esteja ligado e conectado corretamente ao 
computador. Se tiver adquirido uma chave de hardware opcional, certifique-se 
de que seja inserida em uma porta USB no seu computador. 

OBSERVAÇÕES:

• Os clientes do Network Edition o alertarão de que estão obtendo uma 
licença.

• Os clientes do Capture Pro Software Network Edition realizarão 
a sincronização inicial com o Capture Pro Server Software.

• Clique duas vezes no ícone do Capture Pro Software na área 
de trabalho ou

• vá para: Iniciar > Programas > Kodak > Kodak Capture Pro 
Software.
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Seleção do seu 
scanner

Na primeira vez que você iniciar o Capture Pro Software, a mensagem 
O scanner não foi selecionado. Deseja configurá-lo agora? é exibida. 
Clique em Sim para exibir a tela Configuração da estação de trabalho 
(Workstation Setup). Nesta tela, é possível selecionar o scanner que será 
usado na lista de scanners disponíveis. Essa etapa não se repetirá nas 
próximas vezes que o software for iniciado.

1. Clique em Selecionar (Select). A tela Selecionar scanner 
(Select Scanner) será exibida.

2. Selecione o scanner que está instalado no seu computador e clique em 
OK. A tela de Inicialização rápida (Quick Start) será exibida.

3. Clique em OK na tela Configuração da estação de trabalho (Workstation 
Setup).

4. Selecione Importação automática (Auto Import) se desejar importar 
imagens para o Capture Pro sem usar um scanner físico ou intervir 
manualmente.
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Inicialização rápida A tela de Inicialização rápida (Quick Start) fornece um menu com as funções 
e trabalhos comumente usados.

A página de trabalho exibe as configurações de trabalho que foram criadas. 
Os elementos são exibidos em ordem alfabética e podem mudar de cor se 
outros elementos do trabalho forem adicionados ou excluídos.

OBSERVAÇÃO: nomes de trabalho longos não cabem no botão e serão 
truncados. Passe o mouse sobre o botão para exibir o nome 
completo do trabalho. Recomenda-se que as primeiras 
palavras do nome do trabalho sejam únicas e descritivas.

Gerenciador de lotes (Batch Manager) — permite abrir lotes de documentos 
existentes, criar novos lotes ou visualizar o status de qualquer lote existente.

Menu principal (Main Menu) — exibe a tela principal do Capture Pro 
Software. Você pode abrir manualmente ou criar um novo lote, iniciar 
a captura de documento, editar as configurações de trabalho, editar usuários 
e grupos, bem como realizar várias tarefas de configuração do sistema.

Logout — desconecta o usuário atual.

Sair (Exit) — sai do Capture Pro Software.

Ao clicar em um trabalho, um novo lote será criado e a digitalização começará 
como definida pela configuração do trabalho. Após sair de um trabalho, a tela 
de Inicialização rápida será exibida novamente.

OBSERVAÇÕES: 

• Caso seja um usuário experiente ou não queira usar a Inicialização rápida 
de trabalho, você pode desativá-la desmarcando a Exibição de 
inicialização rápida (Quick Start View) na caixa de diálogo Configuração 
da estação de trabalho (Workstation Setup). Para acessar a caixa de 
diálogo de Configuração da Estação de trabalho, vá até a tela principal 
e selecione Arquivo > Configuração da estação de trabalho 
(File > Workstation Setup). 

• O ícone Inicialização rápida (Quick Start) encontra-se na barra de 
ferramentas Exibir (View) e pode ser utilizado para navegar de volta para 
a tela Inicialização rápida (Quick Start) do Menu principal (Main Menu).

• A Inicialização rápida é desativada para a edição Somente índice ou 
Importação automática.
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Caixa de diálogo 
Gerenciador de lotes 
(Batch Manager)

Ao fazer login no Capture Pro Software, se a opção Exibição de inicialização 
rápida (Quick Start View) não estiver ativada, a caixa de diálogo Gerenciador 
de lotes (Batch Manager) não será exibida. A caixa de diálogo Gerenciador de 
lotes (Batch Manager) também pode ser exibida selecionando Lote > Abrir 
(Batch > Open). Use essa caixa para gerenciar todos os lotes associados às 
suas configurações de trabalho.

Trabalhos disponíveis (Available jobs) — lista todas as suas configurações 
de trabalho. Selecione um lote a partir de qualquer uma dessas configurações 
de trabalho.

Lotes do trabalho selecionado (Batches of the selected job) — exibe os 
campos Nome do trabalho (Job Name), Nome do lote (Batch Name), Hora de 
criação (Time Created), Status do lote (Batch Status) e Bloqueado por (Locked 
By) para os trabalhos selecionados.

Opções de exibição (Show Options) — exibe a caixa de diálogo Opções de 
exibição (Show Options), que permite selecionar os estados (ou seja, 
Disponível (Available), Processando (Processing) etc.) a serem exibidos no 
campo Status do lote (Batch Status) da caixa de diálogo Gerenciador de lotes 
(Batch Manager).

Abrir (Open) — exibe o lote selecionado na lista. O comando Abrir não 
abrirá um lote listado como Em uso (In Use). É necessário ter permissão para 
leitura/gravação no local da imagem digitalizada para abrir o lote existente.
Novo (New) — exibe a caixa de diálogo New Batch (Novo lote), que permite 
criar um novo lote.

Clique para exibir todos os lotes em todas as configurações de 
trabalho.

Clique para ocultar todos os lotes em todas as configurações de 
trabalho.
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Renomear (Rename) — exibe a caixa de diálogo Renomear lote (Rename 
Batch), que permite renomear o lote selecionado.
Excluir (Delete) — exclui o lote selecionado. Uma caixa de confirmação será 
exibida para confirmar a exclusão.
Saída (Output) — envia o lote a ser processado. 
OBSERVAÇÃO: para licenças dos grupos A e B, um scanner físico deve ser 

conectado para saída de lotes. Se você precisa produzir um 
lote sem um scanner conectado, uma licença de indexação 
pode ser comprada.

Fechar (Close) — fecha a caixa de diálogo.

Criação de um novo 
lote

Para digitalizar documentos, é necessário criar um novo lote ou abrir um 
existente no qual os documentos serão digitalizados. Na maioria dos casos, 
o administrador do sistema já configurou os trabalhos que você usará. 
Esses trabalhos serão listados na caixa de diálogo Gerenciador de lotes 
(Batch Manager).

Para criar um novo lote:

1. Inicie o Capture Pro Software. A caixa de diálogo Gerenciador de lotes 
(Batch Manager) será exibida.

2. Selecione Novo (New). A caixa de diálogo Novo lote (New Batch) será 
exibida.

3. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job name). O novo lote será capturado e gerado como definido 
nesta configuração de trabalho.

4. Se for o caso, digite um novo nome de lote no campo Nome do lote (Batch 
name). Por padrão, o Capture Pro Software sugere um novo nome de lote 
de acordo com o último nome de lote criado para a configuração do 
trabalho. Por exemplo, se o último nome de lote for Saúde030, o novo 
nome de lote padrão será Saúde031.
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OBSERVAÇÃO: para clientes do Network Edition. Quando Ativar 
numeração de lote de nível de trabalho (Enable Job 
Level Batch Numbering) estiver desmarcada em 
Configuração da estação de trabalho (Workstation 
Setup) e o nome do lote tiver <BATCH_COUNTER>, 
o nome do lote será Definido pelo sistema (Set by 
System) e não poderá ser alterado.

5. Se for o caso, digite a ID do documento inicial (starting document ID). 
A ID do documento inicial é a ID que você deseja atribuir ao primeiro 
documento em um lote. Na maioria dos casos, essa ID é 1. Por padrão, 
o software sugere um número de documento inicial com base na 
configuração do trabalho.

6. Clique em OK. O Visualizador de imagens (Image Viewer) será exibido 
na janela principal com o nome de lote atribuído por você. O Visualizador 
de imagens (Image Viewer), o Explorador de lotes (Batch Explorer) 
e o Visualizador de miniaturas (Thumbnail Viewer) permanecerão em 
branco até que você comece a digitalizar imagens.

7. Também é possível criar um novo lote. Para isso, clique no ícone Novo 
lote (New Batch) na barra de ferramentas.

Abertura de um lote 
existente

Para abrir um lote existente:

1. Selecione Lote > Abrir (Batch > Open). A caixa de diálogo Gerenciador 
de lotes (Batch Manager) será exibida. Dependendo das suas 
configurações, os lotes de todas as configurações de trabalho serão 
exibidos.

2. Realce o lote que você deseja abrir e clique em Abrir (Open). O lote 
selecionado será exibido no Visualizador de imagens (Image Viewer) e no 
Explorador de lotes (Batch Explorer). Agora você pode trabalhar nesse 
lote.

3. Ao clicar em Abrir lote (Open Batch), a caixa de diálogo Gerenciador de 
lotes (Batch Manager) será exibida.

OBSERVAÇÃO: se você estiver trabalhando em um ambiente com vários 
scanners e o lote selecionado já estiver aberto em outra 
estação de trabalho, o Capture Pro Software não deixará 
você abrir esse lote. A mensagem Não é possível abrir 
o lote porque ele está atualmente sendo utilizado por 
outro usuário (The batch cannot be opened because it 
is currently in use by another user) será exibida. 
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Exclusão de um lote Excluir um lote apaga tanto as imagens quanto a estrutura de subdiretórios do 
lote selecionado.

1. Selecione Lote > Abrir (Batch > Open). A caixa de diálogo Gerenciador 
de lotes (Batch Manager) será exibida. Dependendo das suas 
configurações, os lotes de todas as configurações de trabalho serão 
exibidos.

2. Realce o lote que você deseja excluir e clique em Excluir (Delete). 
A mensagem Tem certeza de que deseja excluir os lotes “XXXXX” 
selecionados? (Are you sure you want to delete the selected batch 
“XXXXX”?) será exibida.

3. Clique em OK.



A-61992_pt-br  Março de 2022 9

Uso de um trabalho Esta seção fornece as etapas básicas para criar um novo lote, digitalizar 
e enviar um lote. Informações detalhadas sobre indexação, definição de 
zonas de OCR, leitura de patches, seleção de diferentes fontes de saída, 
entre outras, estão disponíveis no Guia do administrador do Capture Pro 
Software da Kodak Capture Pro Software.

OBSERVAÇÃO: existem diversas maneiras de concluir uma ação quando se 
usa o Capture Pro Software. Por exemplo, se você deseja 
abrir um lote, pode selecionar Lote > Abrir (Batch > Open) 
na barra de menus, pode clicar no botão Abrir lote (Open 
Batch) da barra de ferramentas ou pode pressionar a tecla 
de atalho F3. Neste manual, todas as ações são descritas 
através da barra de menus. Para obter uma lista completa 
de menus, botões da barra de ferramentas e teclas de 
função, consulte “A interface do usuário” na página 17.

1. Se você ainda não iniciou o Capture Pro Software, faça-o agora. A caixa 
de diálogo Gerenciador de lotes (Batch Manager) será exibida.

2. Clique em Novo (New). A tela Novo lote (New Batch) será exibida.

3. Selecione a configuração de trabalho desejada na caixa suspensa Nome 
do trabalho (Job name). O nome do lote e a ID do documento inicial são 
preenchidos automaticamente. Você pode alterá-los, se desejar. 



10 A-61992_pt-br  Março de 2022

4. Clique em OK. A tela principal será exibida e você estará pronto para 
iniciar a digitalização. 

5. Coloque a pilha de documentos que você deseja digitalizar na bandeja de 
entrada do scanner.

6. Clique em Iniciar (Start). O scanner alimentará as páginas.

7. Quando seus documentos tiverem sido digitalizados, você poderá 
executar qualquer opção de edição que for necessária (ou seja, remover 
páginas em branco, girar imagens, cortar imagens etc.). Consulte “Opções 
de edição” na página 11 para ver uma breve descrição de algumas das 
opções disponíveis.

8. Quando você estiver satisfeito com seu lote, selecione Lote > Saída 
(Batch > Output). A tarefa de saída do lote será iniciada e a tela Novo lote 
(New Batch) será exibida, permitindo que você inicie outra sessão de 
digitalização enquanto o processamento é executado em segundo plano. 

OBSERVAÇÃO: para licenças dos grupos A e B, um scanner físico deve 
ser conectado para saída de lotes. Se você precisa 
produzir um lote sem um scanner conectado, uma 
licença de indexação pode ser comprada.

As imagens digitalizadas serão entregues ao local designado. 
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Opções de edição Antes de gerar seu lote, analise as imagens para verificar se elas estão como 
você deseja. Se for necessário fazer alguns ajustes, há ferramentas 
disponíveis para isso. Esta seção apresenta procedimentos para algumas das 
funções de edição mais comuns (ou seja, girar imagens, excluir imagens, 
cortar imagens etc). Procedimentos para dividir e mesclar imagens podem ser 
encontrados no Guia do administrador do Kodak Capture Pro Software. 

Todas as opções de menus e da barra de ferramentas são descritas no 
Capítulo 2, A interface do usuário.

Girar imagens O Capture Pro Software permite que você gire automaticamente as imagens 
durante a digitalização ou manualmente após elas serem digitalizadas. 
As imagens são giradas 90°, 180° ou 270° no sentido horário.

Para girar manualmente as imagens de um lote existente:

1. Clique na imagem, página ou documento, individualmente ou em grupo, 
na lista do Explorador de lotes (Batch Explorer) ou no Visualizador de 
imagens (Image Viewer).

2. Selecione Ferramentas (Tools) > Girar (Rotate) > 90, 180 ou 270. 
As imagens giradas serão exibidas no Visualizador de imagens 
(Image Viewer).
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Demarcação de uma região A ferramenta Demarcar região (Draw Region) permite traçar um retângulo em 
torno de parte de uma imagem e, em seguida, remover a área interna do 
retângulo usando Apagar (Blank) ou cortar a imagem para que fique do 
tamanho do retângulo usando Cortar (Crop).

1. Clique em uma imagem que você deseja cortar ou apagar no Visualizador 
de imagens (Image Viewer).

2. Selecione Ferramentas > Demarcar região (Tools > Draw Region). 

3. Clique e arraste o cursor de demarcação de região para criar um retângulo 
sobre a parte da imagem que você deseja selecionar. Solte o cursor; 
o retângulo ficará verde.

4. Agora você pode cortar ou apagar a região.

Para descartar uma região:
• Clique com o botão direito do mouse na imagem que contém o retângulo 

verde e selecione Desmarcar região (Deselect Region).

Corte de imagens Você pode cortar uma área fora de uma região retangular criada, usando 
a ferramenta Demarcar região (Draw Region) e a opção Cortar (Crop).

1. Clique na imagem no Explorador de lotes (Batch Explorer) que você 
deseja cortar. A imagem selecionada será contornada em vermelho no 
Visualizador de imagens (Image Viewer).

2. Selecione Ferramentas > Demarcar região (Tools > Draw Region). 
3. Clique e arraste o cursor de demarcação de região para criar um retângulo 

sobre a parte da imagem que você deseja salvar. Solte o cursor; 
o retângulo ficará verde.

4. Selecione Ferramentas > Cortar (Tools > Crop). A área da imagem fora 
do retângulo verde será excluída, e somente a área selecionada 
permanecerá no Visualizador de imagens (Image Viewer).

5. Clique em Sim (Yes) para salvar as configurações.
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Apagar parte de uma 
imagem

Se desejar apagar parte de uma imagem, você poderá demarcar uma região 
dela e usar a ferramenta Em branco (Blank). A área dentro do retângulo ficará 
em branco. 

1. Clique na imagem do Explorador de lotes (Batch Explorer) que você 
deseja apagar.

2. Selecione Ferramentas > Demarcar região (Tools > Draw Region). 
3. Clique e arraste o cursor de demarcação de região para criar um retângulo 

sobre a parte da imagem que você deseja apagar. Solte o cursor; 
o retângulo ficará verde.

4. Selecione Ferramentas > Em branco (Tools > Blank). A imagem exibirá 
uma área em branco onde você posicionou o retângulo verde.

5. Clique em Sim (Yes) para salvar as configurações. 

Anexação de páginas Essa opção permite digitalizar páginas extras e adicioná-las a um documento 
existente. 

1. No Explorador de lotes (Batch Explorer), selecione o documento que 
receberá o anexo.

2. Clique em Documento > Anexar página (Document > Attach Page).
3. Digitalize as imagens. As novas páginas serão exibidas no final do 

documento selecionado. 

Redigitalização de imagens Ao analisar o lote de imagens digitalizadas, ocasionalmente você pode 
constatar a necessidade de redigitalizar alguns documentos.

1. Realce a página ou as páginas que deseja redigitalizar.

2. Coloque os originais na ordem correta no scanner.

3. Clique no ícone Redigitalizar (Rescan). As imagens serão redigitalizadas 
e colocadas em suas posições originais.

Exclusão de imagens Se você deseja excluir as imagens selecionadas de um lote:

1. Selecione a imagem que você deseja excluir.

2. Selecione Editar > Excluir (Edit > Delete). A mensagem Tem certeza de 
que deseja excluir os itens selecionados? (Are you sure you want to 
delete the selected item(s)?) será exibida.

3. Clique em Sim (Yes) para confirmar a exclusão.
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Exclusão de um intervalo 
de documentos

Você pode excluir um intervalo de documentos em um lote existente.

1. Selecione Documento > Excluir intervalo (Document > Delete Range). 
A caixa de diálogo Excluir documentos do intervalo (Delete Documents in 
Range) será exibida.

2. Digite o número do primeiro documento do grupo de documentos que 
você deseja excluir no campo Do documento número (From Document 
Number).

3. Digite o número do último documento do grupo de documentos no campo 
Até o documento número (To Document Number).

4. Clique em OK.

Remoção de imagens em 
branco de um lote

Esta opção permite que você remova as imagens que o scanner deixar em 
branco (frente ou verso).

1. Selecione Lote > Remover imagens em branco (Batch > Remove Blank 
Images). A caixa de diálogo Configuração de Remover imagens em 
branco (Remove Blank Images Setup) será exibida.

2. Digite o número do documento inicial do lote onde você deseja pesquisar 
imagens em branco no campo Iniciar no documento (Start at document). 
O padrão é o documento ativo no momento.

3. Defina o número limite de bytes das imagens que serão verificadas nos 
campos Exibir imagens em escala de cinza abaixo (Show Grayscale 
images below) e Exibir imagens coloridas abaixo (Show Color images 
below). Uma boa configuração para documentos comerciais comuns é de 
3000 bytes a 200 dpi (preto-e-branco).

4. Clique em Marcar apenas o verso (Check only back sides) para remover 
somente os versos em branco das imagens de um lote.

5. Clique em Pré-selecionar tudo (Pre-select all) se todas as imagens forem 
candidatas a exclusão.
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6. Defina o número de colunas e linhas que deseja exibir no campo Layout 
de exibição (Display layout). Em uma tela SVGA de 1024 x 768, a matriz 
de 14 x 7 permite que você verifique 98 imagens por tela.

7. Clique em OK para aceitar os valores digitados. 

Depois de o lote ser examinado, o Capture Pro Software exibirá todas as 
imagens que correspondem aos critérios definidos (por exemplo, versos 
com menos de 5000 bytes) na janela Remover imagens em branco 
(Remove Blank Images). Essas imagens são exibidas em destaque 
vermelho. Todas as imagens coloridas são consideradas em branco 
e estão prontas para serem excluídas.

• Se nenhuma imagem em branco for exibida na janela Remover 
imagens em branco (Remove Blank Images), isso significa que 
o Capture Pro Software não pode localizar nenhuma imagem em 
branco no lote que corresponda ao critério. Você pode clicar em 
Configuração (Setup) na janela Remover imagens em branco 
(Remove Blank Images) para reabrir a caixa de diálogo Configuração 
de Remover imagens em branco (Remove Blank Images Setup) 
e inserir números de limite mais altos (em bytes) para as imagens em 
preto e branco e/ou em cores/tons de cinza.

8. Por padrão, todas as imagens em branco são realçadas em vermelho 
e selecionadas para exclusão. Selecione todas as imagens em branco que 
você não deseja excluir clicando em uma de cada vez. O realce vermelho 
desaparece nessas imagens.

9. Use os botões Primeira tela (First Screen), Tela anterior (Previous 
Screen), Próxima tela (Next Screen) e Última tela (Last Screen) para 
navegar por todas as possíveis imagens em branco do lote.

10. Clique em Remover (Remove). A mensagem Remover todas as 
imagens selecionadas? (Remove all selected images?) será exibida.

11. Selecione Sim (Yes) para confirmar a exclusão das imagens em branco. 
O Capture Pro Software remove as imagens em branco destacadas em 
vermelho, repagina os documentos e atualiza o lote e a capacidade do 
disco rígido disponíveis.
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Geração da saída 
(processamento) do lote

Quando todas as alterações de edição estiverem concluídas, você estará 
pronto para concluir a saída do lote.
O Capture Pro Software permite processar um lote por vez ou todos os lotes 
disponíveis de uma só vez. 
Para gerar a saída do lote atual em uma configuração de trabalho:
1. Selecione Lote > Saída (Batch > Output). 

Quando o lote estiver em fila para saída, a caixa de diálogo Novo lote 
(New Batch) será exibida, permitindo digitalizar outro lote de documentos. 
OBSERVAÇÃO: para licenças dos grupos A e B, um scanner físico deve 

ser conectado para saída de lotes. Se você precisa 
produzir um lote sem um scanner conectado, uma 
licença de indexação pode ser comprada.

2. Clique em OK para continuar a digitalização de imagens no novo lote. 
Quando você envia o lote, ele é processado de acordo com o Destino de 
saída do sistema (System Output Destination) selecionado na guia Saída 
(Output) da caixa de diálogo Configuração do trabalho (Job Setup). 
Normalmente, o resultado é a cópia do lote em um caminho de 
subdiretório de saída.

Para gerar a saída de todos os lotes disponíveis em uma configuração de 
trabalho atual:
• Selecione Lote > Promover a saída de tudo (Batch > Output All). A caixa 

de diálogo Gerenciador de lotes (Batch Manager) será exibida, onde você 
pode selecionar um ou mais lotes a serem produzidos. 

Para exibir o andamento da saída:
• Selecione Lote > Exibir status de saída do lote (Batch > View Batch 

Output Status). A janela Status do processamento de lotes do Kodak 
Capture Pro (Capture Pro Batch Process Status) será exibida. 

Essa janela manterá você atualizado sobre o andamento dos seus lotes 
à medida que eles forem processados. Durante o processamento em 
segundo plano, a digitalização assume a prioridade mais alta. A saída será 
mais lenta até que a digitalização seja concluída.

Eliminação de erros A janela Status em lote do Capture Pro (Capture Pro Batch Status) apresenta 
informações sobre lotes que você está preparando para envio no Capture Pro 
Software.
Para exibir a janela Status de lotes:
• Selecione Lote > Exibir status de saída do lote (Batch > View Batch 

Output Status).

Para limpar os erros:

• Clique com o botão direito do mouse na entrada Nome do lote em Limpar 
todos os erros (Clear All Errors) ou Limpar erros selecionados (Clear 
Selected Errors).
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2   A interface do usuário

Este capítulo fornece descrições da janela principal do Capture Pro Software, 
bem como descrições da barra de menus, das barras de ferramentas e dos 
visualizadores.

Janela Principal A janela principal contém os seguintes componentes.

1 Barra de título do programa — fornece o nome da configuração do 
trabalho.

2 Barra de menus — fornece os seguintes itens de menu: Arquivo (File), 
Lote (Batch), Exibir (View), Capturar (Capture), Documento (Document), 
Editar (Edit), Ferramentas (Tools), Índice (Index) e Ajuda (Help).

3 Barras de ferramentas — fornece as seguintes barras de ferramentas: 
Capturar (Capture), Lote (Batch), Exibir (View), Documento (Document), 
Navegação (Navigation), Sinalizador (Flag), Editar (Edit) e Índice (Index).

4 Explorador de lotes (Batch Explorer) — lista todas as pastas, páginas 
e arquivos de imagens de documentos no lote. 

5 Visualizador de imagens (Image Viewer) — exibe as imagens em um 
lote. O Visualizador de imagens pode ser configurado para mostrar 1, 2, 
4, 8 ou mais imagens por vez.

6 Visualizador de miniaturas (Thumbnail Viewer) — exibe miniaturas de 
todas as imagens do lote.



18 A-61992_pt-br  Março de 2022

7 Guia Índice (Index) — quando você clica nessa guia (localizada no lado 
direito da janela principal), a janela Índice (Index) é exibida, com índices 
em nível de lote ou documento. 

8 Guia Informações (Information) — quando você clica nessa guia 
(localizada no lado direito da janela principal), a janela Informações 
(Information) é exibida, apresentando estatísticas detalhadas sobre 
o lote, o documento, a página e a imagem.
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Barra de menus A barra de menus fornece os seguintes itens: Arquivo (File), Lote (Batch), 
Exibir (View), Capturar (Capture), Documento (Document), Editar (Edit), 
Ferramentas (Tools), Índice (Index) e Ajuda (Help).

Menu Arquivo (File) O menu Arquivo (File) contém as seguintes opções:

Configuração do trabalho (Job Setup) — exibe a caixa de diálogo 
Configuração do trabalho (Job Setup), que permite definir todos os 
parâmetros de uma configuração de trabalho. Consulte o Guia do 
administrador do Kodak Capture Pro Software para obter mais informações. 
Atalho de teclado: J.

Configuração de página (Page Setup) — exibe a caixa de diálogo 
Configuração de página(Page Setup), que permite selecionar uma 
configuração de página predefinida ou criar sua própria configuração de 
página personalizada para sua configuração de trabalho. O Capture Pro 
Software vem com várias configurações de página pré-definidas. A lista de 
configurações de página predefinidas varia de acordo com o scanner que está 
sendo usado. Consulte o Guia do administrador para obter mais informações.

Configuração da estação de trabalho (Workstation Setup) — exibe a caixa 
de diálogo Configuração da estação de trabalho (Workstation Setup), que 
permite selecionar o scanner conectado ao computador para a digitalização 
de documentos no Capture Pro Software. Se licenciado, você também poderá 
selecionar Importação automática para importar imagens automaticamente 
para o Capture Pro Software. Consulte “Configuração da sua estação de 
trabalho” na página 21 para conhecer os procedimentos.

Seleção de trabalho inteligente (Intelligent Job Select) — exibe a caixa de 
diálogo Seleção de trabalho inteligente (Intelligent Job Select), que permite 
que você use as folhas de código de Correção do recurso (Feature Patch) 
para alterar automaticamente as configurações de Trabalho ou Página 
durante a digitalização. Consulte o Guia do administrador para obter mais 
informações.

Importar configuração do trabalho (Import Job Setup) — exibe a caixa de 
diálogo Importar (Import), que permite importar uma configuração de trabalho. 
Consulte o Guia do administrador para obter mais informações.

Exportar configuração do trabalho (Export Job Setup) — exibe a caixa de 
diálogo Exportar (Export), que permite exportar uma configuração de trabalho 
para um arquivo. Consulte o Guia do administrador do Kodak Capture Pro 
Software para obter mais informações.

Configuração do usuário (User Setup) — exibe a caixa de diálogo 
Configuração do usuário (User Setup), que permite ao administrador 
configurar e gerenciar usuários do Capture Pro Software. Consulte o Guia do 
administrador para obter mais informações.

Alterar senha (Change Password) — exibe a caixa de diálogo Alterar senha 
(Change Password), que permite alterar a senha.

Para alterar uma senha:

1. Selecione Arquivo > Alterar senha (File > Change Password). A caixa de 
diálogo Alterar senha (Change Password) será exibida.

2. Digite a Senha antiga (Old Password) e a Nova senha (New Password).

3. Confirme a nova senha digitando-a no campo Confirmar senha (Confirm 
Password).

4. Clique em OK. 



20 A-61992_pt-br  Março de 2022

Idioma (Language) — permite selecionar o idioma no qual a interface do 
usuário é exibida. Os idiomas suportados são: Inglês, francês, italiano, 
alemão, português do Brasil, holandês, espanhol, chinês simplificado, 
chinês tradicional, sueco, coreano, turco, tcheco, russo, árabe, polonês 
e japonês.
Para alterar o idioma:

1. Selecione Arquivo > Idioma (File > Language). 

2. Selecione o idioma desejado. A interface do usuário será exibida no 
idioma selecionado.

OBSERVAÇÃO: a caixa de diálogo de configuração do scanner (driver 
TWAIN) pode exibir caracteres de texto incorretos quando 
o idioma padrão é ocidental e o usuário muda para um 
idioma asiático. Para solucionar esse problema, use as 
“Opções regionais e de idioma” do sistema para definir 
o idioma asiático desejado na opção “Idioma para programas 
não-Unicode”.

Sistema de medição (Measurement System) — permite selecionar unidades 
americanas (US) ou métricas (Metric).

Imprimir (Print) — exibe a caixa de diálogo Configuração da impressão 
(Print Setting) da impressora selecionada, que permite imprimir documentos 
digitalizados. Atalho de teclado: Ctrl + P.

Salvar como PDF (Save As PDF) — exibe a caixa de diálogo Salvar como 
PDF (Save As PDF), que permite salvar imagens digitalizadas em um formato 
PDF pesquisável ou não pesquisável.

Logout — desconecta o usuário atual.

Minimizar na bandeja do sistema (Minimize to System Tray) — minimiza 
o aplicativo Capture Pro Software, mas não fecha o software.

Sair (Exit) — fecha o Capture Pro Software. Atalho de teclado: Alt + F4.
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Configuração da sua estação 
de trabalho

Quando você seleciona Arquivo > Configuração da estação de trabalho 
(File > Workstation Setup), a tela Configuração da estação de trabalho 
(Workstation Setup) é exibida. Nessa tela, é possível configurar as 
informações da estação de trabalho e escolher o scanner que você deseja 
usar.

1. Insira a ID e o Nome (Name) da estação de trabalho. Em um ambiente 
com vários scanners, a ID e o nome devem ser exclusivos.

2. Se você for um usuário experiente e não quiser usar a tela de Inicialização 
Rápida (Quick Start), desmarque a caixa Exibição de Inicialização 
Rápida (Quick Start view). 

3. Clique em Selecionar (Select). A caixa de diálogo Selecionar scanner 
(Select Scanner) será exibida, mostrando uma lista de scanners e de 
outros recursos disponíveis, como Importação automática, dependendo da 
sua licença. 

4. Selecione a origem que você deseja usar e clique em OK. 

5. Insira o Nível de limite do disco (Disk Warning Level) desejado em 
megabytes (MB). Você receberá um aviso se o espaço livre no disco ficar 
abaixo desse nível.
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6. Marque Ativar numeração de lote de nível de trabalho (Enable job level 
batch numbering) se desejar que a sequência numérica do lote seja 
mantida independentemente para cada trabalho. Se essa opção estiver 
marcada, a numeração será mantida no nível do trabalho. Se estiver 
desmarcada, a numeração será mantida no nível do sistema. 
Por exemplo: 

7. Se você selecionar a opção Exibir mensagem de confirmação em 
exclusões manuais (Display confirmation message during manual 
deletion) e inserir um tamanho de página em kilobytes (KB), você receberá 
um aviso ao tentar excluir uma imagem de tamanho superior ao 
especificado.

8. Insira os valores em Limite para reinicialização automática (Automatic 
restart limit) para Limite (Threshold) e Compensação (Offset), se desejar 
que o Capture Pro reinicie automaticamente ao atingir esses limites. 

Por exemplo, se o Limite para reinicialização = 5 e a Compensação para 
reinicialização = 2, o Capture Pro será reiniciado após digitalizar 7 páginas 
na sessão atual.

Ao atingir o limite de reinicialização, a caixa de diálogo Confirmação 
(Confirmation) será exibida, indicando que o número de folhas 
digitalizadas atingiu o limite e perguntando se você deseja continuar até 
atingir o número de compensação de folhas antes de reiniciar. Se clicar 
em Sim (Yes), o Capture Pro digitalizará outras 2 páginas antes de 
reiniciar.

OBSERVAÇÃO: recomendamos que o Limite para reinicialização não 
ultrapasse 8000.

9. Se clicar em Não (No), o Capture Pro será reiniciado automaticamente 
e a opção Limite para reinicialização automática (Automatic restart 
limit) ficará inabilitada ao retomar a digitalização.

Menu Lote (Batch) O menu Lote (Batch) contém as seguintes opções:

Novo (New) — exibe a caixa de diálogo New Batch (Novo lote), que permite 
criar um novo lote.

Abrir (Open) — exibe a caixa de diálogo Batch Manager (Gerenciador de 
lotes), que permite abrir um lote existente. Atalho de teclado: F3. Consulte 
“Introdução” na página 1 para conhecer os procedimentos.

Fechar (Close) — fecha o lote aberto atualmente.

Renomear (Rename) — exibe a caixa de diálogo Renomear lote (Rename 
Batch), que permite renomear um lote atual.

Remover imagens em branco (Remove Blank Images) — exibe a caixa de 
diálogo Configuração de Remover imagens em branco (Remove Blank 
Imagens Setup), que permite remover imagens da frente ou do verso em 
branco produzidas pelo scanner. Atalho de teclado: K. Consulte “Introdução” 
na página 1 para conhecer os procedimentos.

Nível do sistema Nível do trabalho
Faturas INV001 Faturas INV001
Solicitações CLM002 Solicitações CLM001
Registros RCD003 Registros RCD001
Faturas INV004 Faturas INV002
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Saída (Output) — inicia o processamento de todas as imagens no lote atual. 
Atalho de teclado: O. Consulte “Introdução” na página 1 para conhecer os 
procedimentos.

OBSERVAÇÃO: para licenças dos grupos A e B, um scanner físico deve ser 
conectado para saída de lotes. Se você precisa produzir um 
lote sem um scanner conectado, uma licença de indexação 
pode ser comprada.

Promover a saída de tudo (Output All) — inicia o processamento de todas as 
imagens em todos os lotes do trabalho atual. 

Exibir status de saída do lote  (View Batch Output Status) — mostra a janela 
Status do processo em lote do Capture Pro (Capture Pro Batch Process 
Status), que fornece informações sobre o progresso dos lotes em saída. 
Consulte “Janela Status do processo em lote (Batch Process Status)” na 
página 50.

Limpar (Clear) — apaga todas as imagens de um lote, mas mantém intacta 
a sua estrutura de subdiretórios.

Excluir (Delete) — apaga tanto as imagens quanto a estrutura de 
subdiretórios do lote selecionado. Consulte “Introdução” na página 1 para 
conhecer os procedimentos.

Excluir até o fim do lote (Delete to End of Batch) — apaga todas as imagens, 
a partir da que está selecionada até a última imagem do lote.
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Menu Exibir (View) O menu Exibir (View) contém as seguintes opções:

Exibição no Visualizador de imagens (Image Viewer Display) — permite 
selecionar uma grade de 1, 2, 4 ou 8 imagens a serem exibidas na janela 
principal. Ao selecionar Personalizar (Customize), a caixa de diálogo 
Configuração do layout personalizado (Custom Layout Setup) é exibida, 
a qual permite especificar outro tamanho de grade.

Filtro do Visualizador de imagens (Image Viewer Filter) — permite que você 
especifique um ou mais tipos de imagens a serem exibidos no Visualizador de 
imagens (Image Viewer) da janela principal. Você pode selecionar uma ou 
mais das seguintes opções: Frente (Front), Verso (Back), Preto e branco 
(Black & White), Tons de cinza (Grayscale) e Colorido (Color).

Filtro do Visualizador de miniaturas (Thumbnail Viewer Filter) — permite 
especificar um ou mais tipos de imagens a serem exibidos no Visualizador de 
miniaturas (Thumbnail Viewer) da janela principal. Você pode selecionar um 
ou mais dos seguintes filtros: Frente (Front), Verso (Back), Preto e branco 
(Black & White), Tons de cinza (Grayscale) e Colorido (Color).

Tamanho da imagem em miniatura (Thumbnail Image Size) — exibe a caixa 
de diálogo Configuração do tamanho da imagem em miniatura (Thumbnail 
Image Size Setup), que permite especificar o tamanho de cada miniatura a ser 
exibida na janela principal.

Visualizador de imagens (Image Viewer), Explorador de lotes (Batch 
Explorer), Visualizador de miniaturas (Thumbnail Viewer), Informações 
(Information), Índice (Index), Barra de status (Status Bar) — esses 
comandos permitem selecionar se os componentes correspondentes são 
exibidos na janela principal. O atalho de teclado da Barra de status é Ctrl + S.

Barras de ferramentas (Toolbars) — permite exibir ou ocultar as seguintes 
barras de ferramentas: Capturar (Capture), Lote (Batch), Exibir (View), 
Documento (Document), Navegação (Navigation), Sinalizador (Flag), Editar 
(Edit) e Índice (Index). Informações detalhadas sobre as barras de 
ferramentas podem ser encontradas mais adiante neste capítulo.

Tamanho dos ícones (Icon Size) — permite especificar ícones Pequenos 
(Small), Médios (Medium) ou Grandes (Large).

Texto dos ícones (Icon Text) — permite especificar se os rótulos de ícones 
serão exibidos e, nesse caso, à direita ou embaixo dos ícones.

Zoom (Zoom) — aumenta ou diminui o tamanho de exibição de uma imagem. 

• Real (Actual): exibe a imagem em tamanho real (um pixel digitalizado 
é igual a um pixel no Visualizador de imagens).

• Mais zoom (Zoom In): diminui a exibição da imagem pelo incremento 
especificado na caixa de diálogo Configuração da etapa de zoom 
(Zoom Step Setup).

• Menos zoom (Zoom Out): diminui a exibição da imagem pelo incremento 
especificado na caixa de diálogo Configuração da etapa de zoom 
(Zoom Step Setup).

• Etapa de zoom (Zoom Step): exibe a caixa de diálogo Configuração da 
etapa de zoom (Zoom Step Setup), que permite especificar o incremento 
(15%, 20%, 25%, 30%, 35% ou 40%) em que o tamanho da imagem 
é alterado quando os comandos Mais zoom e Menos zoom são usados.



A-61992_pt-br  Março de 2022 25

Aplicar pan a todas as imagens para (Pan All Images to) — permite mover 
todas as imagens no painel do Visualizador de imagens de uma vez. Você 
pode aplicar pan à parte Superior (Top), Inferior (Bottom), Esquerda (Left) ou 
Direita (Right) das imagens.

Configuração da etapa de pan (Pan Step Setup) — exibe a caixa de diálogo 
Configuração da etapa de pan (Pan Step Setup), que permite especificar 
o número desejado de pixels (5, 10, 15, 25, 50 ou 100) com o qual uma 
imagem se move ao usar os comandos Pan.

Layout — permite alternar entre os modos de layout Clássico (Classic) 
e Avançado (Enhanced).

Inicialização rápida (Quick Start) — fornece um menu com as funções 
e trabalhos comumente usados.

Menu Capturar (Capture) O menu Capturar (Capture) contém as seguintes opções:

Iniciar (Start) — ativa o scanner e inicia o transporte. Atalho de teclado: F7.

Parar (Stop) — limpa e para o transporte, desativando o scanner. Atalho de 
teclado: F6.

Lista de configurações de página (Page Setup List) — exibe a caixa de 
diálogo Lista de configurações de página (Page Setup List), que permite 
selecionar dentre as configurações de página definidas. Atalho de teclado: F2.

Modos de captura (Capture modes) — determina como um lote é digitalizado 
ao permitir que você selecione uma das seguintes configurações:
• Frente e verso (Two-Sided): digitaliza a frente e o verso de uma página.
• Frente (One-Sided Front): digitaliza a frente de uma página.
• Verso (One-Sided Back): digitaliza o verso de uma página.

Selecionar scanner (Select Scanner) — exibe a caixa de diálogo 
Configuração da estação de trabalho (Workstation Setup), que permite 
selecionar o scanner que você deseja usar.

Importação manual de imagens (Manual Import Images) — permite importar 
arquivos de imagem criados de outras fontes (por exemplo, um scanner de 
desenhos de engenharia) para o documento exibido atualmente no Capture 
Pro Software. 

Quando você selecionar Importação manual de imagens (Manual Import 
Images), a caixa de diálogo Abrir (Open) será exibida. Navegue até o diretório 
de onde você deseja importar as imagens e selecione o(s) arquivo(s) de 
imagem. Arquivos de imagem BMP, JPEG, PDF, TIFF, IOCA, MODCA, GIF, 
CMP e PNG podem ser importados. As imagens selecionadas para serem 
importadas serão inseridas imediatamente antes da imagem selecionada no 
documento que está sendo exibido. Se não houver imagens selecionadas, as 
imagens importadas serão anexadas no fim do documento que está sendo 
exibido.

Tanto os arquivos TIFF de página única como os de várias páginas são 
suportados. Ao importar um arquivo TIFF de várias páginas, cada imagem no 
arquivo será importada como uma imagem separada no documento.

É possível selecionar mais de uma imagem no arquivo para importação. 
Se mais de um arquivo de imagem for selecionado, as imagens serão 
importadas em ordem alfabética/numérica de acordo com o nome do arquivo 
da imagem.
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Exibir tarefas de importação automática pendentes (View Pending Auto-
Import Tasks) — exibe uma tabela com todos os trabalhos de importação 
automática enviados para o Capture Pro usando a API (interface de 
programação da aplicação) Importação Automática que ainda não foram 
concluídos. 

Configuração da importação automática (Auto Import Setup) — exibe 
a caixa de diálogo Configuração da importação automática (Auto Import 
Setup), que permite configurar “pastas monitoradas” de importação 
automática. Você pode identificar pastas monitoradas e atribuir-lhes nomes 
intuitivos usando a caixa de diálogo Configuração de imagem automática 
(Auto Image Setup). Também é possível identificar diretórios para 
arquivamento e tratamento de erros, atribuir níveis de limite de erros, 
especificar regras de separação de lote de importação automática e intervalos 
de tempo imite. Consulte o Guia do administrador do Kodak Capture Pro 
Software para obter mais informações.

Definir endereço da imagem (Set Image Address) — exibe a caixa de 
diálogo Endereço da imagem (Image Address), que permite alterar as 
configurações de endereço de imagem do seu lote. Essa opção somente fica 
ativa quando você usa um scanner com capacidade de endereçamento de 
imagens.

Definir contador (Set Counter) — exibe a caixa de diálogo Definir contador 
(Set Counter), que permite redefinir o valor sequencial do contador atribuído 
(e opcionalmente impresso) à página que for digitalizada em seguida. 
Essa opção somente fica ativa quando você usa um scanner com contador.

Menu Documento 
(Document)

O menu Documento (Document) contém as seguintes opções:

Novo (New) — cria um novo documento cujo número será igual ao do último 
documento, mais “1”. Atalho de teclado: Ctrl + Enter.

OBSERVAÇÃO: em alguns scanners, selecionar Novo (New) também ativa 
o scanner e inicia o transporte/alimentador ou a mesa 
digitalizadora modular.

Anexar página (Attach Page) — permite digitalizar imagens extras e 
adicioná-las como páginas a um documento existente. Atalho de teclado: F4.

Inserir páginas (Insert Pages) — insere páginas adicionais em um 
documento digitalizado. Atalho de teclado: Insert.

OBSERVAÇÃO: se o endereço da imagem e a detecção de correções 
estiverem definidos, Inserir páginas não provocará uma 
separação do documento quando uma correção do 
documento for detectada. 

Redigitalizar páginas (Rescan Pages) — reinicia o scanner e substitui as 
páginas selecionadas do documento pelas novas páginas degitalizadas. 
Atalho de teclado: R.

Dividir documento (Split Document) — divide um documento em dois a partir 
do ponto definido na página selecionada.

Mesclar com anteriores (Merge into Previous) — coloca o documento que 
está sendo digitalizado no documento anterior.

Excluir (Delete) — exclui o documento aberto no momento. Atalho de teclado: F8.

Excluir intervalo (Delete Range) — exibe a caixa de diálogo Excluir 
documentos do intervalo (Delete Documents in Range), que permite excluir 
um intervalo de documentos do lote.
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Excluir até o fim do documento (Delete to End of Document) — permite que 
você exclua a imagem selecionada e todas as imagens subsequentes de um 
documento. Esse comando remove as imagens do disco rígido. Essa função 
não pode ser desfeita.

Ir para documento (Go to Document) — permite que você opte entre ir para 
o documento seguinte, anterior, primeiro ou último no lote, ou então selecione 
um Número de documento (Document Number) para ir para um documento 
específico no lote.

Ir para a imagem (Go to Image) — abre a caixa de diálogo Ir para a imagem 
(Go to Image), que permite navegar para uma imagem específica no 
documento atual. Atalho de teclado: I.

Menu Editar (Edit) O menu Editar (Edit) contém as seguintes opções:

Desfazer (Undo) — reverte em um nível a última ação. Se uma ação não 
puder ser desfeita, uma mensagem será exibida. Atalho de teclado: Ctrl + Z.

Copiar (Copy) — copia uma imagem selecionada para colar em outro local. 
Atalho de teclado: Ctrl + C.

Copiar área da imagem (Copy Image Area) — após usar Demarcar região 
(Draw Region) para criar uma região na imagem, esta opção permite copiar 
essa região em outro lugar. Atalho de teclado: Ctrl + I.

Copiar imagem na configuração do trabalho (Copy Image to Job Setup) — 
exibe a caixa de diálogo Copiar imagem na configuração do trabalho (Copy 
Image to Job Setup), que permite importar imagens para a janela Código de 
barras (Bar Code) ou a janela OCR, a fim de criar códigos de barras ou zonas 
de OCR.

Selecionar tudo (Select All) — seleciona todas as imagens do lote atual. 
Atalho de teclado: Ctrl + A.

Selecionar documento (Select Document) — seleciona todas as imagens do 
documento atual.

Selecionar filtrados (Select Filtered) — seleciona todas as imagens cujos 
parâmetros filtrados estão selecionados.

Desmarcar tudo (Deselect All) — cancela a seleção de todas as imagens. 
Atalho de teclado: Ctrl + D.

Selecionar sinalizados (Select Flagged) — seleciona todas as imagens que 
estão sinalizadas. Atalho de teclado: Ctrl + F.

Excluir (Delete) — exclui as imagens selecionadas do lote. Atalho de teclado: 
Del.
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Menu Ferramentas 
(Tools)

O menu Ferramentas (Tools) contém as seguintes opções:

Seletor (Selector) — exibe a ferramenta de ponteiro (Pointer), que permite 
selecionar imagens. Você também pode selecionar imagens usando 
a ferramenta de ampliação (Magnify). Consulte Ampliar abaixo. Atalho de 
teclado: S.

Modo de seleção (Selection mode) — selecione Imagem (Image), 
Página (Page) ou Lado da página (Page Side). 

• Se selecionar Imagem (Image), você poderá clicar em uma imagem no 
Visualizador de imagens para que apenas a imagem seja selecionada.

• Se selecionar Página (Page), você poderá clicar na imagem para que 
a página inteira, frente e verso, em preto e branco e em cores/escala de 
cinza, seja selecionada.

• Se estiver digitalizando várias imagens em um lado (digitalização colorida 
e bitonal de frente e verso), quando você selecionar Lado da página 
(Page Side) e clicar em uma imagem da frente, todas as imagens da frente 
serão selecionadas. Se você clicar no verso de uma imagem, todas as 
imagens do verso serão selecionadas.

Ampliar (Magnify) — amplia uma parte da imagem. Se você selecionar 
Ampliar (Magnify), a ferramenta de Ampliar (Magnify) será exibida. Você pode 
ampliar qualquer área em que colocar a ferramenta Ampliar (Magnify). 
(Mantenha pressionado o botão esquerdo do mouse para ampliar a imagem. 
Clicar com o botão esquerdo do mouse selecionará a imagem.) Atalho de 
teclado: M.

Aplicar pan (Pan) — permite que você mova a imagem em torno do painel 
Visualizador de imagens (Image Viewer) quando a imagem for maior do que 
o painel. Atalho de teclado: P. Clicar com o botão esquerdo do mouse 
selecionará a imagem.

Demarcar região (Draw Region) — permite traçar um retângulo em torno de 
parte de uma imagem e, em seguida, remover a área interna do retângulo 
usando Apagar (Blank); ou cortar a imagem para que fique do tamanho do 
retângulo usando Cortar (Crop) (ou copiá-la usando Editar > Copiar área da 
imagem (Edit > Copy Image Area)).

Coeficiente de ampliação (Magnification Ratio) — exibe a caixa de diálogo 
Configuração do coeficiente de ampliação (Magnification Ratio Setup), que 
permite selecionar o coeficiente de ampliação de 100%, 150%, 200%, 250% 
ou 300%.

Para ampliar uma imagem existente no Visualizador de imagens ou no 
Visualizador de miniaturas:

1. Selecione Ferramentas > Ampliar (Tools > Magnify).

2. Clique em uma imagem, e segure e arraste a ferramenta Ampliar sobre ela.

Girar (Rotate) — gira manualmente a imagem selecionada 90, 180 ou 270 
graus no sentido horário. O Capture Pro Software permite que você gire 
automaticamente as imagens durante a digitalização ou manualmente após 
elas serem digitalizadas.



A-61992_pt-br  Março de 2022 29

CQ inteligente (Intelligent QC) — abre a Ferramenta CQ inteligente 
(Intelligent QC). Todas as imagens selecionadas ficarão disponíveis para 
revisão e processamento. Se nenhuma imagem tiver sido selecionada, todas 
as imagens sinalizadas ficarão disponíveis. A ferramenta QC inteligente pode 
também ser aberta clicando com o botão direito do mouse em uma imagem no 
Visualizador de imagens (Image Viewer) ou no Explorador de lotes (Batch 
Explorer) e selecionando QC inteligente (Intelligent QC) na lista de seleção. 
Para ver mais informações, consulte “A caixa de diálogo Ferramenta CQ 
inteligente (Intelligent QC Tool)” na página 30.

Opções da ferramenta Sinalizar (Flag Tool options) — permitem sinalizar 
uma imagem que necessite ser digitalizada novamente ou ajustada de alguma 
forma (por exemplo, valores de contraste talvez precisem ser ajustados para 
fornecer uma melhor qualidade de imagem). Atalho de teclado: C.

• Ferramenta Sinalizar (Flag Tool): permite sinalizar uma página, imagem ou 
frente e verso da imagem.

• Sinalizar tudo selecionado (Flag All Selected): sinaliza todas as imagens 
selecionadas do lote para redigitalização.

• Sinalizar documento (Flag Document): sinaliza todas as imagens do 
documento selecionado.

• Sinalizar filtrados (Flag Filtered): permite aplicar um filtro às imagens 
exibidas no Visualizador de imagens (Image Viewer). Uma vez selecionado 
o visualizador ao qual aplicar o filtro, você pode selecionar as imagens da 
frente (Front Side) ou do verso (Back Side), em preto e branco (Black 
and White), tons de cinza (Grayscale) ou coloridas (Color).

• Cancelar sinalização de tudo selecionado (Unflag All Selected): remove 
as sinalizações das imagens selecionadas.

• Cancelar sinalização de tudo (Unflag All): remove todas as imagens 
previamente sinalizadas do lote atual. 

Dividir Documento (Split Document) — divide um documento em dois.

Cortar (Crop) — permite cortar a área externa do retângulo criado com a 
opção Demarcar região (Draw Region). Uma caixa de confirmação será 
exibida quando você selecionar essa opção. Atalho de teclado: Ctrl + R. 

Em branco (Blank) — permite apagar a área interna do retângulo que você 
criou usando a opção Demarcar região (Draw Region). Uma caixa de 
confirmação será exibida quando você selecionar essa opção. Atalho de 
teclado: Ctrl + B. 

Marcar como “em branco” (Mark As Blank) — marca as imagens como “em 
branco” quando essa opção está selecionada no menu de ferramentas ou ao 
clicar com o botão direito do mouse na imagem selecionada. Uma imagem 
que foi marcada como “em branco” é identificada por uma borda azul. Se você 
selecionar essa opção em uma imagem que já está marcada, ela será 
desmarcada. Essa opção só estará disponível quando a opção Manter 
imagens em branco (Keep blank images), em de Exclusão automática (Auto 
Delete), estiver habilitada para a configuração de página atual.
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A caixa de diálogo Ferramenta 
CQ inteligente (Intelligent QC 
Tool)

Selecionar o ícone CQ inteligente (Intelligent QC) na barra de ferramentas 
Editar (Edit) abrirá a Ferramenta CQ inteligente (Intelligent QC Tool). Todas as 
imagens selecionadas ficarão disponíveis para revisão e processamento. 
Se nenhuma imagem tiver sido selecionada, todas as imagens sinalizadas 
ficarão disponíveis. A ferramenta QC inteligente pode também ser aberta 
clicando com o botão direito do mouse em uma imagem no Visualizador de 
imagens (Image Viewer) ou no Explorador de lotes (Batch Explorer) 
e selecionando QC inteligente (Intelligent QC) na lista de seleção.

A Ferramenta CQ inteligente não fica disponível durante a digitalização, 
a redigitalização ou quando Importar automaticamente está monitorando 
ativamente os arquivos de imagem da pasta Hot Folder.

Quando você acessar a ferramenta, a primeira imagem será mostrada no 
painel de imagens esquerdo. O painel de imagens esquerdo mostrará 
a imagem como ela ficará se nenhum processamento de imagem adicional for 
aplicado.

O painel de imagens direito mostrará como a imagem ficará se 
o processamento de imagem selecionado for aplicado.

Você pode editar a imagem clicando em uma ou mais das ferramentas de 
processamento de imagens localizadas entre os painéis de imagem. 
Para desfazer uma determinada função de processamento de imagem, clique 
na ferramenta novamente para desmarcá-la.

Algumas ferramentas de processamento de imagem fornecem controles 
adicionais para ajustar a aparência da imagem. Por exemplo, a ferramenta 
Binarizar (Binarize) fornece um controle de contraste. O ajuste do contraste 
permitirá que você veja texto muito claro enquanto mantém o ruído de fundo 
dentro dos níveis aceitáveis.

Aplicar configurações à próxima imagem (Apply settings to next image) — 
quando marcada, as ferramentas de processamento da imagem selecionada 
e as configurações da ferramenta serão aplicadas à próxima imagem quando 
apropriado. Se Binarizar (Binarize) estiver selecionada, e a imagem seguinte 
estiver preto e branco, a binarização não será aplicada. Entretanto, se 
Preenchimento de furos (Hole Fill) estiver ativado também, ela será aplicada 
à imagem em preto e branco. 
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Aplicar a tudo (Apply To All) — aplicará as ferramentas de processamento de 
imagem selecionadas a todas as imagens selecionadas pela Ferramenta CQ 
inteligente.

Avançar (Next) — se imagens adicionais estiverem disponíveis para revisão, 
o botão Avançar ficará disponível. Clicar em Avançar (Next) salva a imagem 
atual como exibida no painel de imagens direito. Se Aplicar à próxima 
(Apply to Next) estiver selecionada, as ferramentas de processamento da 
imagem selecionada serão aplicadas à próxima imagem. A imagem antes do 
processamento será exibida no painel de imagens esquerdo, e a imagem 
processada será exibida no painel de imagens direito. 

Voltar (Back) — mostra a imagem exibida anteriormente. Todas as seleções 
de ferramenta ficarão desativadas, e Aplicar à próxima (Apply to Next) ficará 
desmarcada. A imagem será exibida como ela estava quando o botão 
Avançar (Next) foi selecionado.

Exibir preto e branco/Exibir escala de cinza/Cor (View B&W / View 
Grayscale / Color) — quando houver uma imagem em escala de cinza/em 
cores e imagens em preto e branco associadas (fluxo dual), a imagem em 
preto e branco será exibida no painel de imagens esquerdo. Para exibir 
a imagem em escala de cinza/em cores, clique no botão Exibir escala de 
cinza/Cor (View Grayscale/Color).

Menu Índice (Index) O menu Índice (Index) contém as seguintes opções:

Editar campos de índice (Edit Index Fields) — oferece acesso a campos de 
índice nos níveis de lote e documento. Atalho de teclado: E.

OBSERVAÇÃO: para as licenças dos grupos A e B, um scanner físico deve 
ser conectado para edição de campos de índice. Se você 
precisa indexar sem um scanner conectado, uma licença de 
indexação pode ser comprada.

Documento anterior (Previous Document) — exibe as informações de índice 
do documento anterior. Atalho de teclado: F9.

Próximo documento (Next Document) — exibe as informações de índice do 
próximo documento. Atalho de teclado: F10.

Próximo inválido (Next Invalid) — exibe as informações de índice do próximo 
documento no qual há um índice inválido. Atalho de teclado: F11.

Índice 1 (Index1) — permite indicar que o lote está pronto para indexação.

Índice 2 (Index2) — permite indicar que o lote está pronto para a segunda 
entrada de índice quando se utiliza a Entrada de dados dupla (Double Data 
Entry).

OBSERVAÇÃO: ao utilizar a Entrada de dados dupla (Double Data Entry), se 
você, como o operador de captura, estiver também inserindo 
os primeiros valores de índice, será preciso primeiro 
selecionar Índice 1 (Index1) e depois selecionar Índice 2 
(Index2) quando o lote estiver pronto para a segunda entrada 
de valores de índice. Para obter mais informações sobre 
Dupla entrada de dados, consulte “Uso da Entrada de dados 
dupla” na página 33.
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Definir comportamento da tecla Enter (Define Enter Key Behavior) — 
permite atribuir uma ação que você queira que o software execute quando 
você pressionar a tecla Enter. As opções são: ir para o Próximo documento 
(go to the Next Document), ir para o Próximo documento inválido(go to 
the Next Invalid document) e Salvar a indexação e sair (Save & Exit 
Indexing).

Zonas de zoom (Zoom Zones) — permite traçar um retângulo em torno da 
parte da imagem cuja exibição será ampliada ao editar campos de índice. 
Essa configuração do zoom é salva por campo de índice. Assim, você pode 
definir uma zona de zoom para cada campo de índice, e a exibição será feita 
automaticamente com zoom na parte apropriada da imagem quando o campo 
for editado.

OCR de arrastar e soltar (Drag-and-Drop OCR) — permite preencher um 
campo de índice traçando uma região na imagem. O OCR é realizado nessa 
região, e o valor é automaticamente colocado nesse campo de índice. Depois 
de selecionar a ferramenta, trace um retângulo ao redor dos dados de índice 
a serem capturados. 

OBSERVAÇÃO: para que caracteres especiais de alguns idiomas 
(por exemplo, « or ¸) ou caracteres de código MICR sejam 
gerados em OCR adequadamente, selecione o idioma 
apropriado ou a fonte MICR na lista suspensa.

OCR em um clique (One Click OCR) — permite que você clique em uma 
palavra ou valor para definir o campo de índice selecionado. Para acrescentar 
várias palavras ou valores, pressione a tecla Ctrl e clique sobre as palavras ou 
valores adicionais.

Idioma do OCR (OCR Language) — permite configurar o idioma a ser usado 
para a função OCR. 

Salvar a indexação e sair (Save & Exit Indexing) — sai da indexação e salva 
as alterações feitas no lote. Atalho de teclado: F12.

Cancelar a indexação e sair (Cancel & Exit Indexing) — sai da indexação 
sem salvar as alterações feitas no lote. Atalho de teclado: Esc.

Uso da pesquisa de banco de 
dados

Depois que a digitalização tiver sido realizada e o usuário entrar no modo 
Índice (Índice > Editar campos de índice (Index > Edit Index Fields)), a 
pesquisa será sempre realizada em um documento quando este for acessado 
no modo Indexação.

Se o campo de índice que está sendo usado para a pesquisa já possuir um 
valor (por exemplo, de um código de barras ou OCR de zonas), a pesquisa de 
um documento será realizada automaticamente ao navegar até ele.

Se os dados estiverem sendo digitados manualmente no campo de índice, 
a pesquisa será realizada quando o usuário deixar o campo de índice. 
Se a tecla Tab for usada para sair do campo de índice que acabou de ser 
digitado, os resultados do preenchimento de outros campos de índice serão 
exibidos para verificação. Se a tecla Enter ou uma das teclas de função do 
modo Indexação (por exemplo, F9, F10, F11) for usada para navegar para 
outro documento, a pesquisa será realizada e outros campos de índice serão 
preenchidos. Entretanto, você não verá os resultados da pesquisa, pois esse 
documento não estará mais sendo exibido no modo Indexação.

Se o campo de índice da pesquisa for preenchido usando OCR com opção 
arrastar e soltar, a pesquisa será realizada imediatamente e os resultados do 
preenchimento de outros campos de índice serão exibidos para verificação.
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Se o valor que está sendo usado para a pesquisa for somente parcialmente 
conhecido, o asterisco “*” pode ser usado para substituir os caracteres 
desconhecidos. O asterisco deve ser o último caractere. Por exemplo, se o 
valor da pesquisa for um número de telefone mas se somente os primeiros 
quatro dígitos puderem ser lidos, o valor “557-3*” pode ser digitado. Todos os 
números de telefone que começam com “557-3xx....” serão obtidos do banco 
de dados e você pode selecionar o valor correto.

Quando uma pesquisa é baseada em dois valores e somente um valor é 
conhecido, o asterisco pode ser usado no lugar do valor desconhecido. Por 
exemplo, a pesquisa é baseada no Sobrenome E Nome e o endereço será 
pesquisado. Se somente for conhecido o sobrenome, ele é digitado no campo 
do índice “Sobrenome” e um asterisco é digitado no campo do índice “Nome”. 
Se somente for encontrado um registro para o sobrenome digitado, o nome e 
o endereço serão preenchidos. Se forem encontrados vários registros para o 
sobrenome, a caixa de diálogo Múltiplos resultados (Multiple Results) será 
exibida e a entrada correta pode ser escolhida. 

Uso da Entrada de dados 
dupla 

Um trabalho que tem um ou mais campos de índice de lote ou documento 
configurados como Entrada dupla é usado para digitalizar documentos como 
qualquer outro trabalho.

Quando a digitalização do documento está concluída e o lote está pronto para 
indexação, o operador seleciona Índice > Índice 1. Isso altera o Status do lote 
(Batch Status) de Disponível (Available) para Índice 1 (Index1), significando 
que o lote está pronto para a entrada do primeiro conjunto de valores de 
índice.

Quando o operador do primeiro índice tiver inserido os valores de índice de 
todos os documentos, Índice > Índice 2 (Index > Index2) será selecionado. 
Isso altera o Status do lote (Batch Status) de Índice 1 (Index1) para Índice 2 
(Index2), significando que o lote agora está pronto para a entrada do segundo 
conjunto de valores de índice.

O operador do segundo índice não verá os valores inseridos pelo operador do 
primeiro índice.
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Se o valor inserido pelo operador do segundo índice corresponder ao primeiro 
valor, nenhuma ação será necessária, e a indexação continuará.

Se o primeiro e o segundo valores não corresponderem, a caixa de diálogo 
Resolução de entrada (Entry Resolution) será exibida, e a entrada correta 
será selecionada pelo operador.

OBSERVAÇÕES:

• Se o operador de digitalização também estiver inserindo o primeiro conjunto 
de valores de índice, ele precisará selecionar Índice > Índice 1 (Index > 
Index1) e selecionar imediatamente Índice > Índice 2 (Index > Index2) ao 
digitalizar, e a operação do primeiro índice estará concluída.

• A comparação dos valores de Índice 1 e Índice 2 possui diferenciação entre 
maiúsculas e minúsculas. Por exemplo, “LETRA MAIÚSCULA” não 
corresponde a “Letra maiúscula”. Além disso, os zeros à esquerda são 
importantes. Por exemplo, o valor 123 não corresponde a 0123.

• Os campos de índice de Entrada dupla (Double Entry) terão qualquer 
espaço em branco à esquerda e à direta removidos antes de o valor ser 
salvo. 

Por exemplo, se o valor “    Envio     ” for inserido, ele será salvo como 
“Envio”. Isso significa que se Índice 1 for inserido como “     Envio” e Índice 2 
for inserido como “Envio     ” os valores corresponderão.

Resolução da entrada (Entry 
Resolution)

A caixa de diálogo Resolução da entrada (Entry Resolution) é exibida quando 
o segundo valor de índice não corresponde ao primeiro.

O operador de índice tem as seguintes opções:

• Selecionar a entrada feita pelo operador do primeiro índice selecionando 
Entrada 1 (Entry1).
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• Selecionar a entrada feita por ele selecionando Entrada 2 (Entry2).

• Inserir um novo valor no campo Nova entrada (New Entry) se nenhuma das 
entradas estiver correta.

• Cancelar e fechar a caixa de diálogo Resolução de entrada (Entry 
Resolution) se ele não quiser fazer uma escolha. Se for tomada uma 
decisão de não resolver o valor de índice sem correspondência em um ou 
mais campos de índice obrigatórios, a seguinte mensagem será exibida se 
for feita uma tentativa de enviar o lote, Um ou mais campos do índice 
requerem Entrada dupla. O Lote não pode ser enviado neste momento. 
Deseja entrar no modo Índice? (One or more index fields require 
Double Entry. You may not output the batch at this time. Do you wish 
to enter Index Mode?) 

Se nenhum dos campos de Entrada dupla (Double Entry) for obrigatório, 
a caixa de diálogo Resolução da entrada (Entry Resolution) será exibida na 
saída. Todos os campos de índice de Entrada dupla (Double Entry) sem 
correspondências de entrada deverão ser resolvidos antes do envio.

OBSERVAÇÕES:

• Se um campo de Entrada dupla (Double Entry) não for obrigatório, uma ou 
mais entradas de índice poderão ser deixadas em branco, e a caixa de 
diálogo Resolução de entrada (Entry Resolution) não será exibida; não 
haverá nenhum erro no envio.

• Se ambos os valores de Entrada dupla (Double Entry) forem inseridos 
e não corresponderem, o operador deverá fazer uma seleção na caixa de 
diálogo Resolução (Entry Resolution) de entrada antes do envio.

• Um campo de índice ativado para Entrada dupla (Double Entry) não pode 
ser usado para realizar uma Pesquisa de banco de dados (Database 
Lookup) ou ser um campo verificado ou preenchido pela Pesquisa de banco 
de dados (Database Lookup).
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Menu Ajuda (Help) O menu Ajuda (Help) contém as seguintes opções:

Ajuda (Help) — exibe a ajuda on-line para o Capture Pro Software. Atalho de 
teclado: F1.

Guia de Introdução para Capture Pro (Capture Pro Getting Started Guide) 
— exibe o guia que fornece procedimentos simples para usar o Capture Pro 
Software e começar rapidamente.

Enviar relatório de erros (Send Error Report) — exibe a caixa de diálogo 
Enviar relatório de erros (Send Error Report), que permite digitar uma 
mensagem descrevendo o problema e enviá-la à Kodak Alaris.

Gerenciador de licenças (License Manager) — acessa o Gerenciador de 
licenças, que fornece a maneira mais fácil de obter uma licença para uma 
estação de trabalho executando o Capture Pro Software que não possui 
acesso à internet.

Registrar (Register) — permite registrar o Capture Pro Software.

Capture Pro Online (Capture Pro Online) — exibe a ajuda on-line para 
o Capture Pro Software.

Sobre o Capture Pro (About Capture Pro) — exibe a caixa de diálogo Sobre 
o Capture Pro Software (About Capture Pro), que fornece informações sobre 
a versão atual do software. Use esta caixa para visualizar as seguintes 
informações:

• Direitos Autorais (Copyright)
• Extensão de arquivo (File extension)
• Caminho de arquivo (File path)
• Número de série do software (Software serial number)
• Número da versão do software (Software version number)

Essa caixa de diálogo também permite o acesso às Informações do sistema, 
que abre a janela Informações de arquivos (Files Information). Esta janela 
fornece informações sobre arquivos individuais do Capture Pro Software. 
A janela Informações de arquivos (Files Information) é somente leitura.
• Nome do arquivo (File name)
• Tamanho do arquivo (File size)
• Data de criação (Creation date)
• Número da versão (Version number)
• Descrição (Description)

OBSERVAÇÃO: clique no “X” no canto superior direito para fechar a janela 
Informações de arquivos.
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Barras de 
ferramentas

Barra de ferramentas 
Capturar (Capture)

A barra de ferramentas Capturar (Capture) contém os seguintes comandos:

Barra de ferramentas 
Lote (Batch)

A barra de ferramentas Lote (Batch) contém os seguintes comandos:

Barra de ferramentas 
Documento (Document)

A barra de ferramentas Documento (Document) contém os seguintes 
comandos:

Iniciar (Start) — inicia a digitalização de imagens no scanner.

Interromper digitalização (Stop Scan) — interrompe 
a digitalização de imagens.

Nome da configuração de página (Page Setup name) — selecione um 
nome de configuração de página na lista suspensa que seja mais adequado 
ao trabalho que você está digitalizando.

Configuração de página (Page Setup) — exibe a caixa de 
diálogo Configuração de página (Page Setup), que permite 
configurar parâmetros de digitalização.
Faces a capturar (Sides to Capture) — permite selecionar 
Frente e verso (Two-sided), Frente (One-Sided Front) 
e Verso (One-Sided Back).
OBSERVAÇÃO: talvez você não consiga usar esta opção com 

alguns scanners que não são da Kodak. 

Novo lote (New batch) — exibe a caixa de diálogo Novo lote 
(New batch), que permite criar um novo lote.
Abrir lote (Open batch) — exibe a caixa de diálogo Gerenciador 
de lotes (Batch Manager), que permite abrir um lote existente.

Fechar lote (Close batch) — fecha o lote aberto atualmente.

Promover a saída do lote (Output batch) — inicia a saída de 
todas as imagens do lote atual.

Novo documento (New Document) — permite adicionar um 
novo documento.

Inserir páginas (Insert pages) — insere páginas adicionais em 
um documento digitalizado. Realce a primeira imagem de uma 
página para que o ícone fique ativo. Coloque as páginas 
adicionais no scanner e clique nesse ícone.
Redigitalizar páginas (Rescan pages) — repete a digitalização 
de partes selecionadas do documento. Realce a(s) página(s) 
a redigitalizar, coloque os originais no scanner e clique nesse 
ícone.
Dividir documento (Split documento) — divide um documento 
em dois na página selecionada. Para dividir um documento, 
clique em Dividir documento (Split document). No Visualizador 
de Imagens (Image Viewer), clique na página que será dividida 
em um novo documento. 
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Barra de ferramentas 
Visualizar (View)

A barra de ferramentas Visualizar (View) contém os seguintes comandos:

Barra de ferramentas 
Navegação (Navigation)

A barra de ferramentas Navegação (Navigation) contém os seguintes 
comandos:

Seletor (Selector) — exibe a ferramenta de ponteiro, que 
permite selecionar imagens.

Modo de seleção (Selection mode) — selecione Imagem 
(Image), Página (Page) ou Lado da página (Page Side). 
• Se selecionar Imagem (Image), você poderá clicar em uma 

imagem no Visualizador de imagens para que apenas 
a imagem seja selecionada.

• Se selecionar Página (Page), você poderá clicar na imagem 
para que a página inteira, frente e verso, em preto e branco 
e em cores/escala de cinza, seja selecionada.

• Se estiver digitalizando várias imagens em um lado 
(digitalização colorida e bitonal de frente e verso), quando 
você selecionar Lado da página (Page Side) e clicar em uma 
imagem da frente, todas as imagens da frente serão 
selecionadas. Se você clicar no verso de uma imagem, todas 
as imagens do verso serão selecionadas.

Ampliar (Magnify) — permite que você amplie uma parte da 
imagem. Se você selecionar Ampliar (Magnify), a ferramenta de 
Ampliar (Magnify) será exibida. Você pode ampliar qualquer 
área em que colocar a ferramenta. (É necessário clicar e manter 
na imagem.)
Aplicar pan (Pan) — permite que você mova a imagem em 
torno da janela quando a imagem for maior do que ela.

Exibição no Visualizador de imagens (Image Viewer Display) 
— permite que você use a seta para baixo para exibir 1, 2, 4 
ou 8 imagens, ou Personalizar (Customize) o layout. Quando 
você selecionar Personalizar (Customize), a caixa de diálogo 
Configuração do layout personalizado (Custom Layout Setup) 
será exibida, permitindo que você digite o número de linhas 
e colunas que quer que apareçam no Visualizador de imagens 
(Image Viewer).
Mais zoom (Zoom In) — amplia todas as imagens no 
Visualizador de imagens (Image Viewer).

Menos zoom (Zoom Out) — reduz todas as imagens no 
Visualizador de imagens (Image Viewer).

 

Inicialização rápida (Quick Start) — abre a tela Inicialização 
rápida (Quick Start), que exibe os trabalhos disponíveis para 
iniciar uma digitalização.

Primeiro documento (First Document) — exibe o primeiro 
documento do lote no Visualizador de imagens (Image Viewer).
Último documento (Last Document) — exibe o último 
documento do lote no Visualizador de imagens (Image Viewer).

Documento anterior (Previous Document) — exibe 
o documento anterior do lote no Visualizador de imagens 
(Image Viewer).
Próximo documento (Next Document) — exibe o próximo 
documento do lote no Visualizador de imagens (Image Viewer).
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Barra de ferramentas 
Sinalizar (Flag)

A barra de ferramentas Sinalizar (Flag) contém os seguintes comandos:

Barra de ferramentas 
Editar (Edit)

A barra de ferramentas Editar (Edit) contém os seguintes comandos:

Ferramenta Sinalizar (Flag Tool) — permite sinalizar uma 
página ou imagem. Por exemplo, você pode querer identificar 
permanentemente imagens que precisam ser redigitalizadas.
Sinalizar tudo selecionado (Flag All Selected) — sinaliza todas 
as imagens selecionadas do lote.

Sinalizar filtrados (Flag Filtered) — permite sinalizar as 
imagens exibidas atualmente no Visualizador de imagens 
(Image Viewer) ou Visualizador de miniaturas (Thumbnail 
Viewer). 
Cancelar sinalização de tudo (Unflag All) — remove as 
sinalizações de todas as imagens sinalizadas anteriormente no 
lote atual.

Editar campos de índice (Edit Index Fields) — oferece acesso 
a campos de índice nos níveis de lote e documento.

Girar 90 (Rotate 90) — gira a(s) imagem(ns) selecionada(s) 
90 graus no sentido horário.

Girar 180 (Rotate 180) — gira a(s) imagem(ns) selecionada(s) 
180 graus no sentido horário.

Girar 270 (Rotate 270) — gira a(s) imagem(ns) selecionada(s) 
270 graus no sentido horário.

CQ inteligente (Intelligent QC) — abre a Ferramenta CQ 
inteligente (Intelligent QC). Todas as imagens selecionadas 
ficarão disponíveis para revisão e processamento. Se nenhuma 
imagem tiver sido selecionada, todas as imagens sinalizadas 
ficarão disponíveis. A ferramenta QC inteligente pode também 
ser aberta clicando com o botão direito do mouse em uma 
imagem no Visualizador de imagens (Image Viewer) ou no 
Explorador de lotes (Batch Explorer) e selecionando QC 
inteligente (Intelligent QC) na lista de seleção.
Demarcar região (Draw Region) — permite desenhar um 
retângulo em torno de uma parte da imagem e remover a área 
dentro do retângulo usando Branco (Blank); ou cortar a imagem 
no tamanho do retângulo usando Cortar (Crop).
Cortar (Crop) — permite remover a área externa do retângulo 
criado com a opção Demarcar região (Draw Region). 

Em branco (Blank) — permite apagar a área interna do 
retângulo que você criou usando a opção Demarcar região 
(Draw Region). Uma caixa de confirmação será exibida quando 
você selecionar esse ícone. 
Imprimir (Print)— exibe a caixa de diálogo Configuração de 
impressão, que permite imprimir um documento inteiro ou 
imagens específicas dentro de um documento.
Salvar como PDF (Save as PDF) — exibe a caixa de diálogo 
Salvar como PDF (Save as PDF), que permite salvar um 
documento completo ou imagens individuais como um arquivo 
PDF pesquisável ou não pesquisável.
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Barra de ferramentas 
Índice (Index)

A barra de ferramentas Índice (Index) contém os seguintes comandos:

Barra de ferramentas 
Ajustes do scanner 
(Scanner Adjustments)

A barra de ferramentas Ajustes do scanner (Scanner Adjustments) permite 
alterar as seguintes opções de digitalização diretamente da janela principal do 
Capture Pro Software:

Excluir selecionadas (Delete Selected) — exclui uma ou mais 
imagens selecionadas de um documento. Por exemplo, caso as 
imagens em branco de um documento frente e verso sejam 
excluídas, todas as imagens remanescentes serão 
renumeradas após a exclusão das imagens selecionadas. 
Uma caixa de confirmação será exibida quando você selecionar 
esse ícone.
Desfazer (Undo) — reverte para a última ação de cortar, apagar 
ou de rotação de uma imagem ou conjunto de imagens. A 
opção Desfazer não reverte comandos de exclusão.

Documento anterior (Previous document) — vai para o número 
de documento anterior que contenha imagens.

Próximo documento (Next document) — vai para o próximo 
número de documento que contenha imagens.

Próximo inválido (Next Invalid) — vai para o próximo 
documento que tenha um índice inválido.

Zonas de zoom (Zoom Zones) — amplia a exibição dos dados 
de índice capturados do campo atual, permitindo ver mais 
claramente os caracteres especiais específicos de um 
determinado idioma que sejam difíceis de ler.
OCR de arrastar e soltar (Drag-and-Drop OCR) — permite 
arrastar e soltar indexação via reconhecimento óptico de 
caracteres (OCR, Optical Character Recognition) sem digitar 
o valor do índice. Depois de selecionar a ferramenta, trace um 
retângulo ao redor dos dados de índice a serem capturados.
Este ícone permite que você clique em uma palavra ou valor 
para definir o campo de índice selecionado. Para acrescentar 
várias palavras ou valores, pressione a tecla Ctrl e clique sobre 
as palavras ou valores adicionais.
Idioma do OCR (OCR Language) — permite selecionar 
o idioma do OCR na lista suspensa. 

Salvar a indexação e sair (Save & Exit Indexing) — salva as 
alterações feitas no lote atual e fecha a janela Índice. 

Cancelar a indexação e sair (Cancel & Exit Indexing) — fecha 
a janela Índice sem salvar as alterações.

Limite (Threshold) — controla a claridade e os pontos 
escuros do fundo de uma imagem. Os valores válidos vão 
de 0 a 255. Há uma configuração de Limite separada para 
as imagens de frente e verso.

Frente Verso
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OBSERVAÇÕES:

• A barra de ferramentas Ajustes do scanner (Scanner Adjustments) só está 
disponível com scanners Kodak e só pode ser usada com eles.

• Qualquer alteração feita nas configurações será temporária e não 
modificará a Configuração de página (Page Setup) selecionada que estiver 
em uso para digitalização.

• Quando uma alteração for feita em uma das configurações da barra de 
ferramentas, a configuração será realçada em amarelo para indicar 
a alteração.

• Quando a Configuração de página (Page Setup) a ser usada para 
digitalização for alterada ou se a mesma Configuração de (Page Setup) for 
selecionada novamente, as configurações da barra de ferramentas Ajustes 
do scanner (Scanner Adjustments) serão redefinidas com os valores 
definidos na Configuração de página (Page Setup).

Explorador de lotes 
(Batch Explorer)

O Explorador de lotes (Batch Explorer) exibe todas as pastas de documentos 
e arquivos de página e imagem do lote que está aberto no Visualizador de 
imagens (Image Viewer). Ele aparece automaticamente do lado esquerdo da 
Janela principal quando o layout Avançado está ativo.

• Clique em um arquivo de imagem no Explorador de lotes (Batch Explorer) 
para que a imagem seja exibida no Visualizador de imagens (Image Viewer).

• Arraste um arquivo de imagem, de página ou uma pasta de documento para 
um local diferente no Explorador de lotes (Batch Explorer).

Contraste (Contrast) — destaca as bordas contidas nos 
documentos. Quanto maior o nível de contraste, maior será 
o destaque das bordas da imagem. Os valores válidos vão 
de 0 a 100 ou de -50 a 50, dependendo do modelo do 
scanner. Há uma configuração de Contraste separada para 
as imagens de frente e verso.
iThresholding — quando essa opção é selecionada, 
o scanner determina automaticamente a configuração de 
Limite ideal para cada página digitalizada, melhorando 
assim a produtividade geral da digitalização e a qualidade 
da imagem. Selecionando essa opção, a configuração de 
Limite para as imagens de frente e verso fica esmaecida 
e indisponível para alteração.

Frente Verso
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• Clique com o botão direito do mouse em um arquivo de imagem, de página 
ou uma pasta de documento para exibir um menu contextual e obter mais 
opções.

• Pressione a tecla Ctrl mais:

+ para expandir todos os nós

- para recolher todos os nós

L para criar um novo documento que começa com a página selecionada

X para cortar a página ou a imagem selecionada

V para colar a última página ou imagem cortada antes da página ou 
imagem selecionada

- Se uma página tiver sido cortada por último e uma imagem for 
selecionada quando Ctrl + V for selecionada, a página será inserida 
antes da página que contém a imagem selecionada.

- Se uma imagem tiver sido cortada por último e uma página for 
selecionada quando Ctrl + V for selecionada, a imagem será inserida 
antes da primeira imagem das páginas selecionadas.

Visualizador de 
imagens (Image 
Viewer)

O Visualizador de imagens (Image Viewer) é a área em que as imagens 
podem ser visualizadas. Você pode exibir 1, 2, 4 ou 8 imagens de uma vez ou 
personalizar o layout do Visualizador de imagens (Image Viewer).

A barra de título contém o nome do lote e o número do documento das 
imagens exibidas no Visualizador de imagens (Image Viewer). 

Para mover uma imagem:
1. Selecione uma imagem.
2. Arraste a imagem para o local desejado.

Para excluir uma imagem:
1. Selecione uma imagem. 
2. Selecione Editar > Excluir (Edit > Delete). A imagem será excluída do 

documento.

Para alterar o número de imagens exibidas:
1. Selecione Exibir > Exibição no Visualizador de imagens (View > Image 

Viewer Display).
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2. Selecione 1, 2, 4, 8 ou Personalizar (Customize). O Visualizador de 
imagens exibirá o layout selecionado.

OBSERVAÇÃO: se você selecionar Personalizar (Customize), a caixa de 
diálogo Configuração do layout personalizado (Custom 
Layout Setup) será exibida, permitindo que você digite 
o número de linhas e colunas a serem exibidos.

Menu contextual Imagem 
(Image)

Quando você clica com o botão direito do mouse em uma imagem no 
Visualizador de imagens (Image Viewer), um menu oferece as seguintes 
opções:

Marcar como “em branco” (Mark As Blank) — marca as imagens como “em 
branco” quando essa opção está selecionada no Visualizador de imagens 
(Image Viewer) ou ao clicar com o botão direito do mouse na imagem 
selecionada. Essa opção só estará disponível quando a opção Manter 
imagens em branco (Keep blank images), em Exclusão automática (Auto 
Delete), estiver habilitada para a configuração de página atual. Quando uma 
imagem é selecionada, ela é destacada por uma borda grossa em azul escuro 
no Visualizador de imagens.

Modo de seleção (Selection Mode) — selecione Imagem (Image), Página 
(Page) ou Lado da página (Page Side). 

• Se selecionar Imagem (Image), você poderá clicar em uma imagem no 
Visualizador de imagens para que apenas a imagem seja selecionada.

• Se selecionar Página (Page), você poderá clicar na imagem para que 
a página inteira, frente e verso, em preto e branco e em cores/escala de 
cinza, seja selecionada.

• Se estiver digitalizando várias imagens em um lado (digitalização colorida 
e bitonal de frente e verso), quando você selecionar Lado da página 
(Page Side) e clicar em uma imagem da frente, todas as imagens da frente 
serão selecionadas. Se você clicar no verso de uma imagem, todas as 
imagens do verso serão selecionadas.

Desmarcar tudo (Deselect All) — cancela a seleção das imagens destacadas 
no Visualizador de imagens (Image Viewer).

Excluir (Delete) — exclui as imagens destacadas após a confirmação do 
usuário.

Copiar (Copy) — copia uma imagem selecionada para colar em outro local.

Copiar área da imagem (Copy Image Area) — após usar Demarcar região 
(Draw Region) para criar uma região na imagem, esta opção permite copiar 
essa região em outro lugar.

Copiar imagem na configuração do trabalho (Copy Image to Job Setup) — 
exibe a caixa de diálogo Copiar imagem na configuração do trabalho (Copy 
Image to Job Setup), que permite importar imagens para a janela Código de 
barras (Bar Code) ou a janela OCR, a fim de criar códigos de barras ou zonas 
de OCR.

Girar (Rotate) — gira a imagem selecionada 90, 180 ou 270 graus no sentido 
horário.

CQ inteligente (Intelligent QC) — abre a Ferramenta CQ inteligente 
(Intelligent QC). Todas as imagens selecionadas ficarão disponíveis para 
revisão e processamento. Se nenhuma imagem tiver sido selecionada, todas 
as imagens sinalizadas ficarão disponíveis.
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Dividir documento (Split Documento) — realiza uma separação manual do 
documento, que divide o documento selecionado em dois.

Mesclar com anteriores (Merge into Previous) — anexa o documento 
selecionado ao documento anterior para criar um único documento.

Zoom (Zoom) — aumenta ou diminui o tamanho de exibição de uma imagem. 

• Ajustar imagens à janela (Fits Images to window): ajusta cada imagem ao 
seu painel no Visualizador de imagens (Image Viewer), independentemente 
do seu tamanho original.

• Real (Actual): amplia uma imagem até seu tamanho real.

• Mais zoom (Zoom in): amplia uma imagem por meio de um percentual fixo, 
de acordo com a configuração da Etapa de Zoom (Zoom Step).

• Menos zoom (Zoom out): reduz uma imagem por meio de um percentual 
fixo, de acordo com a configuração da Etapa de Zoom (Zoom Step).

• Etapa de zoom (Zoom Step): acessa a caixa de diálogo Etapa de zoom 
(Zoom Step), que permite especificar um percentual de ampliação/redução 
entre 15 e 40%, aumentando de 5 em 5%.

Aplicar pan a todas as imagens para (Pan All Images to) — permite mover 
todas as imagens para a posição Superior (Top), Inferior (Bottom), Esquerda 
(Left), Direita (Right) ou Mesma (Same) posição.

Configuração da etapa de pan (Pan Step Setup) — exibe a caixa de diálogo 
Configuração da etapa de pan (Pan Step Setup), que permite alterar as 
configurações de pixel da ferramenta Pan.

Ocultar frente (Hide Front) — oculta todas as imagens de frente do lote. 

Ocultar verso (Hide Back) — oculta todas as imagens de verso do lote.

Ocultar preto e branco (Hide Black and White) — oculta todas as imagens 
em preto e branco do lote.

Ocultar tons de cinza (Hide Grayscale) — oculta todas as imagens em tons 
de cinza do lote.

Ocultar cores (Hide Color) — oculta todas as imagens coloridas do lote.

Se você selecionar a ferramenta Sinalizar (Flag), Ampliar (Magnify) ou 
Demarcar região (Draw Region) antes de clicar com o botão direito do 
mouse em uma imagem, opções adicionais serão exibidas no menu.

• Se a ferramenta Sinalizar (Flag) estiver ativa, as opções de sinalização 
serão exibidas. 

- Sinalizar tudo selecionado (Flag All Selected) — coloca marcas de 
seleção verdes em todas as imagens selecionadas do lote. Para 
selecionar mais de uma imagem, mantenha pressionado a tecla Ctrl 
enquanto clica nas imagens no Visualizador de imagens.

- Sinalizar tudo (Flag All) — coloca marcas de seleção verdes em todas 
as imagens do lote.

- Cancelar sinalização de tudo (Unflag All) — remove as marcas de 
seleção verdes de todas as imagens do lote.

- Sinalizar filtrados (Flag Filtered) — coloca marcas de seleção verdes 
em todas as imagens filtradas (exibidas).
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• Se a ferramenta Ampliar (Magnify) estiver ativa, a opção Coeficiente de 
ampliação (Magnification Ratio) será exibida. Essa opção exibe a caixa de 
diálogo Coeficiente de ampliação (Magnification Ratio), que permite 
especificar o tamanho de imagem exibido quando você usa a ferramenta 
Ampliar (Magnify).

• Se a ferramenta Demarcar região (Draw Region) estiver ativa, as opções 
relativas a essa ferramenta serão exibidas. 

- Aplicar região ao documento (Apply Region to Document) — coloca 
a região selecionada em todas as imagens do documento.

- Aplicar região ao que estiver selecionado (Applies Region to 
Selected) — coloca a região selecionada apenas nas imagens 
selecionadas.

- Cortar (Crop) — permite remover a área externa do retângulo criado com 
a opção Demarcar região (Draw Region). Uma caixa de confirmação será 
exibida quando você selecionar essa opção.

- Em branco (Blank) — permite apagar a área interna do retângulo que 
você criou usando a opção Demarcar região (Draw Region). Uma caixa 
de confirmação será exibida quando você selecionar essa opção.
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Visualizador de 
miniaturas 
(Thumbnail Viewer)

O Visualizador de miniaturas (Thumbnail Viewer) fornece versões em 
miniatura de todas as imagens do lote que está aberto.

Para selecionar uma imagem no Visualizador de imagens (Image Viewer):

• Clique na miniatura no Visualizador de miniaturas (Thumbnail Viewer).

Para ampliar uma miniatura:

• Clique com o botão esquerdo na imagem e mantenha o botão pressionado. 
Você pode mover a área ampliada mantendo o botão pressionado.

Menu contextual 
Visualizador de 
miniaturas

Quando você clicar com o botão direito do mouse em uma imagem, as 
seguintes opções de menu serão exibidas:

Frente (Front) ou Verso (Back) — oculta todas as miniaturas das imagens de 
frente ou verso. 

Preto e branco (Black and White), Tons de cinza (Grayscale) ou Colorido 
(Color) — oculta todas as miniaturas de imagens em preto e branco, em tons 
de cinza ou coloridas.

Tamanho da imagem em miniatura (Thumbnail Image Size) — a caixa de 
diálogo Configuração do tamanho da imagem em miniatura (Thumbnail Image 
Size Setup) será exibida, permitindo que você altere o tamanho da imagem.

Ferramenta CQ 
inteligente 
(Intelligent QC Tool)

Selecionar Ferramenta CQ inteligente (Intelligent QC Tool) na barra de 
ferramentas Editar (Edit) abrirá a Ferramenta CQ inteligente (Intelligent QC 
Tool). Todas as imagens selecionadas ficarão disponíveis para revisão 
e processamento. Se nenhuma imagem tiver sido selecionada, todas as 
imagens sinalizadas ficarão disponíveis. A Ferramenta CQ inteligente 
(Intelligent QC Tool) pode também ser aberta clicando com o botão direito do 
mouse em uma imagem no Visualizador de imagens (Image Viewer) ou no 
Explorador de lotes (Batch Explorer) e selecionando CQ inteligente (Intelligent 
QC) na lista de seleção.

OBSERVAÇÃO: A Ferramenta CQ inteligente não fica disponível durante 
a digitalização, a redigitalização ou quando Importar 
automaticamente está monitorando ativamente os arquivos 
de imagem da pasta Hot Folder.
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Quando você seleciona a Ferramenta CQ inteligente (Intelligent QC Tool), 
a primeira imagem será mostrada no painel de imagens esquerdo. O painel de 
imagens esquerdo mostrará a imagem como ela ficará se nenhum 
processamento de imagem adicional for aplicado. O painel de imagens direito 
mostrará como a imagem ficará após o processamento de imagem ser 
aplicado.

Você pode editar a imagem clicando em uma ou mais das ferramentas de 
processamento de imagens localizadas entre os painéis de imagem. Para 
desfazer uma função de processamento de imagem, clique na ferramenta 
novamente para desmarcá-la.

Aplicar configurações à próxima imagem (Apply settings to next image) — 
quando marcada, as ferramentas de processamento da imagem selecionada 
e as configurações da ferramenta serão aplicadas à próxima imagem quando 
apropriado. Se Binarizar (Binarize) estiver selecionada, e a imagem seguinte 
estiver preto e branco, a binarização não será aplicada. Entretanto, se 
Preenchimento de furos (Hole Fill) estiver ativado também, ela será aplicada 
à imagem em preto e branco.

Aplicar a tudo (Apply To All) — aplicará as ferramentas de processamento de 
imagem selecionadas a todas as imagens selecionadas pela Ferramenta 
CQ inteligente.

Avançar (Next) — estará disponível e imagens adicionais estiverem 
disponíveis para revisão. Clicar em Avançar (Next) salvará a imagem atual 
como exibida no painel Imagem processada. Se a caixa de seleção Aplicar 
à próxima (Apply to Next) estiver marcada, as ferramentas de processamento 
da imagem selecionada serão aplicadas à próxima imagem. A imagem antes 
do processamento será exibida no painel de imagens Original, e a imagem 
processada será exibida no painel de imagens Processado (Processed). 

Voltar (Back) — mostra a imagem exibida anteriormente. Todas as seleções 
de ferramenta ficarão desativadas, e a caixa de seleção Aplicar à próxima 
(Apply to Next) ficará desmarcada. A imagem será exibida como ela estava 
quando o botão Avançar (Next) foi selecionado.
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Exibir preto e branco (Exibir escala de cinza/Cor) (View B&W (View 
Grayscale / Color)) — quando houver uma imagem em escala de cinza / em 
cores e imagens em preto e branco associadas (fluxo dual), a imagem em 
preto e branco será exibida no painel de imagens Original. Para exibir 
a imagem em escala de cinza/cor, clique no botão Exibir escala de cinza/Cor 
(View Grayscale/Color).

Janela Índice (Index) Para sua conveniência, a janela Índice no lado direito do Visualizador de 
imagens (Image Viewer) exibe os dados de índice de cada lote e documento 
que possui índices definidos. Ela está disponível como uma guia no lado 
direito da tela. Os dados de índice podem ser mostrados rapidamente 
(ao passar o cursor sobre a guia) ou mantidos fixos na exibição da imagem 
para mostrar continuamente os campos de índice de todas as imagens 
à medida que são digitalizadas no Capture Pro Software. Você pode usar esse 
recurso para exibir os campos de índice de um documento específico ou de 
um lote inteiro. Para fazer as correções necessárias em um campo de índice, 
é necessário entrar no modo Indexação. Para isso, selecione Editar campos 
de índice (Edit Index Fields) no menu Índice (Index). 

Para abrir a janela Índice (Index):

• Clique na guia janela Índice (Index) no lado direito do Visualizador de 
imagens (Image Viewer). Para impedir a janela de fechar, clique uma vez no 
ícone Fixar (Pin) no canto superior direito da janela.

Para fechar a janela Índice:

• Clique duas vezes no ícone Fixar (Pin) ou em qualquer lugar fora da janela 
Índice. Se a janela estiver aberta e fixada, clique no ícone Fixar (Pin) uma 
vez para fechá-la.
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Janela Informações 
(Information)

A janela Informações (Information) no lado direito do Visualizador de imagens 
(Image Viewer) fornece estatísticas sobre o lote que está aberto. Você pode 
manter aberta a janela Informações para exibir continuamente as estatísticas 
do lote enquanto as imagens são digitalizadas no Capture Pro Software.

As informações nessa janela podem ser exibidas para cada lote, documento, 
página ou imagem. As informações da imagem incluem o número de 
sequência da imagem, ID da página, local no disco, compactação, resolução, 
tamanho da imagem e sequência de impressão.

Para abrir a janela Informações (Information):
1. Realce uma imagem, página ou documento no Explorador de lotes 

(Batch Explorer) ou realce uma imagem no Visualizador de imagens.

2. Clique na janela Informações (Information) no lado direito do Visualizador 
de imagens (Image Viewer). Para impedir a janela de fechar, clique uma 
vez no ícone Fixar (Pin) no canto superior direito da janela.

Para fechar a janela Informações (Information):
• Clique duas vezes no ícone Fixar (Pin) ou em qualquer lugar fora da janela 

Informações. Se a janela estiver aberta e fixada, clique no ícone Fixar (Pin) 
uma vez para fechá-la.
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Janela Status do 
processo em lote (Batch 
Process Status)

A janela Status do processo em lote (Batch Process Status) do Capture Pro 
apresenta informações sobre lotes que você está preparando para envio no 
Capture Pro Software.

Clique em Controle (Control) para exibir o menu Controle (Control):

• Exibir registro (Show Log) — abre uma janela do Bloco de Notas e exibe 
o registro de saída.

• Limpar registro (Clear log) — exclui todas as entradas do registro de 
saída. Uma caixa de confirmação será exibida para verificar sua opção.

• Sobre (About) — abre a caixa de diálogo Sobre o Kodak Capture Pro 
Software (About Capture Pro Software), que possui um comando para 
visualização de todos os arquivos no software.

• Sair (Exit) — abre a caixa de diálogo Opções de encerramento (Shutdown 
Options), que contém comandos para sair do Capture Pro Software. 
O processamento de saída é realizado em segundo plano, 
independentemente do Capture Pro Software. Se você fechar o Capture 
Pro Software, deverá optar se deseja continuar ou interromper 
o processamento da saída.

A janela Status do processo em lote do Capture Pro (Capture Pro Batch 
Process Status) fornece as seguintes informações em cada lote que foi 
emitido ou está sendo emitido: Nome do trabalho (Job Name), Nome do 
lote (Batch Name), Hora do envio (Submit Time), Status, Nome do 
usuário (User Name), Progresso (Progress) e Descrição (Description).
• Clique com o botão direito do mouse na entrada Nome do lote em 

Limpar todos os erros (Clear All Errors) ou Limpar erros selecionados 
(Clear Selected Errors).

Para visualizar a janela Status do processo em lote:
• Selecione Lote > Exibir status de saída do lote (Batch > View Batch 

Output Status).

Barra de status A barra de status do Capture Pro Software apresenta informações sobre o lote 
atual, o documento atual, o espaço livre em disco e se os filtros de exibição de 
imagem estão ativados ou desativados. A barra de status esta localizada na 
parte inferior da tela e pode ser ativada e desativada marcando/desmarcando 
Barra de status (Status bar) no menu Exibir (View) ou usando o atalho Ctrl + S.

A barra de status mostrará o espaço livre em disco em MB, o número de 
documentos, páginas e imagens no lote aberto atualmente, o número de 
imagens no documento exibido atualmente na janela Visualizador de imagens 
(Image Viewer) e o status dos Filtros de imagem (Image Filters).

Se o Filtro de imagem (Image Filter) estiver ativado, isso indica que tipos de 
imagem como “imagens de verso” ou “imagens de escala de cinza” não estão 
sendo mostrados como item de menu selecionado Exibir > Filtro do 
visualizador de imagens (View > Image Viewer Filter).
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Alteração da 
interface da janela 
principal

À medida as páginas são digitalizadas, as imagens vão aparecendo em todos 
os visualizadores exibidos: o Visualizador de imagens (Image Viewer), 
o Visualizador de miniaturas (Thumbnail Viewer) e/ou o Explorador de lotes 
(Batch Explorer). O Capture Pro Software tem dois layouts de tela padrão: 
Clássico e aprimorado. 

O Capture Pro Software permite que você personalize o layout da janela 
principal, movendo as barras de ferramentas, visualizadores etc. de acordo 
com sua preferência e ocultando componentes indesejados da tela.

Essas opções se aplicam ao Visualizador de imagens (Image Viewer), 
ao Explorador de lotes (Batch Explorer), ao Visualizador de miniaturas 
(Thumbnail Viewer), à janela Informações (Information) e à janela Índice (Index). 
Estes ícones ficam localizados no canto superior direito dessas janelas:

O tamanho das imagens nos visualizadores pode ser ajustado conforme 
a necessidade. O Visualizador de imagens (Image Viewer) pode ser ajustado 
para um tamanho fixo ou permanecer no padrão Melhor ajuste (Best Fit), que 
exibe as imagens no melhor tamanho para a tela. 

As barras de ferramentas e as janelas de imagens podem ser movidas ou 
ocultadas conforme você desejar. O Capture Pro Software guarda as 
configurações de cada trabalho quando você sai dele. Ou seja, diferentes 
trabalhos podem ser exibidos da maneira que você quiser para cada um deles 
particularmente. A qualquer momento, você pode selecionar Exibir > Layout > 
Clássico (View > Layout > Classic) (ou Avançado (Enhanced)) e redefinir 
a tela de volta ao layout padrão.

Fecha qualquer janela. Para abrir a janela novamente, selecione 
a janela que você deseja exibir no menu Exibir (View).

Fixa a janela aberta. Para ocultar a janela automaticamente, 
clique no ícone Fixar (Pin).

Oculta automaticamente a janela, deixando somente a barra de 
título aberta. Para mostrar a janela, mova o cursor sobre a barra 
de título.
Os ícones de âncora, representados por quatro pontos na 
vertical, ficam localizados no canto superior esquerdo das janelas. 
Ao selecionar um ícone de âncora e manter o botão do mouse 
pressionado, a âncora da imagem é liberada e setas azuis serão 
exibidas. Enquanto você mantém o botão do mouse pressionado, 
é possível mover a janela para um novo local. Quando a janela 
estiver no local desejado, solte o botão do mouse.
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Se você estiver usando o layout Clássico e desejar adicionar uma janela do 
layout Avançado, abra o menu Exibir (View) e selecione uma janela (ou seja, 
Explorador de lotes, janela Índice). A janela adicional será exibida no layout 
Clássico.

• Layout Clássico (Classic layout) — exibe apenas o Visualizador de 
imagens (Image Viewer). O número de imagens exibidas pode ser 
selecionado entre 1, 2. 4, 8 ou um número personalizável de até 6 colunas 
por 6 linhas.

• Layout Avançado (Enhanced Layout) — mostra o Visualizador de imagens 
(Image Viewer), o Visualizador de miniaturas (Thumbnail Viewer) 
e o Explorador de lotes (Batch Explorer). Cada janela pode ser 
redimensionada conforme a necessidade.
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3   Solução de problemas

Suporte técnico Para obter suporte para o Capture Pro Software, acesse o site da Kodak Alaris 
em www.alarisworld.com/go/CaptureProSupport. As páginas de suporte 
fornecem informações específicas sobre o produto, como acesso a download 
de atualizações, drivers, acessórios e perguntas mais frequentes (FAQs, 
Frequently Asked Questions), além de detalhes sobre as opções de suporte 
disponíveis para o Capture Pro Software no seu país/região.

 

www.kodakalaris.com/go/CaptureProSupport
www.kodakalaris.com/go/CaptureProSupport
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Apêndice A   Atalhos do teclado

Dependendo de onde você está trabalhando no Capture Pro Software, os 
seguintes atalhos estão disponíveis:

• F1-Ajuda está disponível em todos os lugares no Capture Pro Software.

• Explorador de lotes/Visualizador de imagens: estes atalhos estão 
disponíveis:

Geral
J Configuração de trabalho

F2 Mostrar lista de configuração de página
F5 Mostrar configuração de página
F3 Abrir lote
F7 Iniciar captura
F6 Parar captura

Enter Capturar novo documento
Ctrl-Enter Capturar novo documento

O Gerar lote
Ctrl+Shift-W Fechar lote

Ctrl+S Mostrar/ocultar a barra de status
Ctrl+P Imprimir

Visualização e edição
A Ver imagem em tamanho real
F Ajustar imagens à janela

1, 2, 4 ou 8 Definir o número de imagens para ver no 
Visualizador de imagem

Ctrl-F9 Mostrar/ocultar imagens coloridas 
Ctrl-F10 Mostrar/ocultar imagens em tons de cinza 
Ctrl-F11 Mostrar/ocultar imagens em preto e branco 
Ctrl-A Selecionar todas as imagens (Explorador de lotes)
Ctrl-D Desmarcar todas as imagens (Explorador de lotes)
Ctrl-F Selecionar todas as Imagens sinalizadas 

(Explorador de lotes)
F4 Anexar página (documento selecionado)

Insert Inserir páginas na página selecionada
Del Excluir documento selecionado ou páginas 

selecionadas
F8 Excluir documento selecionado
C Selecionar ferramenta de Sinalização
M Selecionar ferramenta de Ampliação
P Selecionar ferramenta Panorâmica
S Selecionar ferramenta de Seleção
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Visualização e edição (continuação)

Panorâmica para cima

Panorâmica para a direita

Panorâmica para baixo

Panorâmica para a esquerda

Shift- Girar 180°

Shift- Girar 90°

Shift- Girar 180°

Shift- Girar 270°

+ Mais zoom
- Menos zoom

Ctrl+L Dividir documento (Explorador de lotes)
K Configuração de Remover imagens em branco
R Redigitalizar imagem(ns) selecionada(s)
Z Selecionar ferramenta Desenhar região

Ctrl-B Região selecionada em branco
Ctrl-R Cortar região selecionada
Ctrl-Z Desfazer último Corte ou Branco
Ctrl-I Copiar área de imagem

Navegação
D Ir para documento número...
I Ir para imagem número...

Explorador de lotes (Batch Explorer)
Ctrl-Home Primeiro documento do lote
Ctrl-End Último documento do lote

Ctrl-Page Up Documento anterior do lote
Ctrl-Page Down Próximo documento do lote

Visualizador de imagens (Image Viewer)
Home Primeira página do documento
End Última página do documento

Page Up Páginas anteriores - todos os documentos
Page Down Próximas páginas - todos os documentos

• Modo de indexação: estes atalhos estão disponíveis:
E Editar campos de índice
F9 Documento anterior

F10 Próximo documento
F11 Próximo documento inválido
F12 Salvar e sair da indexação
Esc Cancelar e sair da indexação
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